
 
 

 
 

Manual del usuario CoatMaster  
 

 

 

 

 
 

 



 
 

 
Flugplatzstrasse 5 
8404 Winterthur 
Suiza 

 

July 2017, Version 17.1  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

Este manual está protegido por derechos de autor. La información que contiene no se puede reproducir, distribuir ni usar 

con fines de competencia, ni poner a disposición de terceros. Asimismo, está prohibida la fabricación de cualquier 

componente con ayuda de este manual sin autorización previa por escrito. 

 

© 2017 Winterthur Instruments AG 

Pol. Ind. Azitain, Parcela 3A 

20600 EIBAR   -  Gipuzcoa  - SPAIN 

 

T. +34 943 82 00 82    -    info@neurtek.com      

www.neurtek.com 

mailto:info@neurtek.com


  Manual del usuario de CoatMaster 

  3/88 

Índice 

1 General ...................................................................................................................... 6 

1.1 Información ................................................................................................................... 6 

1.2 Acerca de este manual ................................................................................................... 6 

1.3 Limitación de responsabilidad ........................................................................................ 6 

1.4 Copyright · Derechos de autor ........................................................................................ 7 

1.5 Condiciones de garantía ................................................................................................. 7 

1.6 Contenido de la entrega ................................................................................................. 7 

2 Seguridad .................................................................................................................. 9 

2.1 Responsabilidad del operario ......................................................................................... 9 

2.2 Cualificación del usuario ................................................................................................ 9 

2.3 Uso debido .................................................................................................................... 9 

2.4 Uso indebido ................................................................................................................. 9 

2.5 Advertencias de señales de seguridad usadas en este manual ....................................... 10 

2.5.1 Descripción de las advertencias de seguridad .............................................................. 10 

2.5.2 Símbolos utilizados ........................................................... ¡Error! Marcador no definido. 

2.6 Seguridadad del producto .................................................... ¡Error! Marcador no definido. 

2.6.1 Peligros generales.......................................................................................................... 12 

2.6.2 Elementos de seguridad integrados .............................................................................. 12 

3 Interface del Hardware CoatMaster  ......................................................................... 13 

3.1 CoatMaster ................................................................................................................. 13 

3.2 CoatMaster Inline ........................................................................................................ 14 

4 Instalación del sistema ..................................................... ¡Error! Marcador no definido. 

4.1 Instalación del hardware.............................................................................................. 18 

4.2 Requisitos de software ................................................................................................ 19 

4.3 Interfaz para conectar al ordenador de control ............................................................. 20 

4.4 Ajustes de red y administrador .................................................................................... 20 

4.4.1 Configurar la red del CoatMaster con CoatMaster Web Client .................................... 20 

4.4.2 Instalar el software CoatMaster Desktop...................................................................... 22 

4.4.3 Seleccionar el idioma ..................................................................................................... 23 

4.4.4 Definir los ajustes del administrador en el sistema operativo ...................................... 24 

5 Midiendo el espesor con CoatMaster ....................................................................... 25 

5.1 Principios de medición ................................................................................................. 25 

5.2 CoatMaster aplicación en superficies ........................................................................... 25 

5.3 Mediciones con CoatMaster Operating System ............................................................. 26 

5.3.1 Medición Manual  ........................................................................................................ 267 

5.3.2 Medición Automática con sensor externo .................................................................... 30 

5.3.3 Estadísticas de medición ............................................................................................... 33 

5.3.4 Avisos y Errores ............................................................................................................. 34 

5.3.5 Información del Sistema ................................................................................................ 36 



Manual de uso de CoatMaster   

 

 

4/88  

5.3.6 Ventanas opcionales para ventana principal ................................................................ 37 

5.4 Medición con el Web Client ......................................................................................... 39 

5.4.1 Monitor .......................................................................................................................... 40 

5.4.2 Ajustes del CoatMaster Web Client .............................................................................. 42 

5.5 Crear nuevas aplicaciones CoatMaster ......................................................................... 42 

5.5.1 Configuración de la aplicación ....................................................................................... 43 

5.5.2 Mediciones de referencia .............................................................................................. 45 

5.5.3 Visualización .................................................................................................................. 46 

5.5.4 Instrumento ................................................................................................................... 48 

5.5.5 Evaluación...................................................................................................................... 49 

5.5.6 Límites ........................................................................................................................... 50 

5.5.7 Informe de calibración .................................................................................................. 51 

5.5.8 Desviación de la aplicación ............................................................................................ 52 

5.6 Aplicaciones CoatMaster para recubrimientos antes de la curación............................... 55 

5.6.1 Medir recubrimientos en polvo antes de la curación ................................................... 55 

5.6.2 Medir recubrimientos húmedos antes de la curación/secado ..................................... 55 

5.6.3 Procedimiento para crear aplicaciones CoatMaster para medir el espesor del 

recubrimiento antes de la curación .............................................................................................. 56 

5.7 Copia de seguridad y transferencia de aplicaciones CoatMaster .................................... 57 

5.7.1 Exportar aplicaciones .................................................................................................... 57 

5.7.2 Importar aplicaciones .................................................................................................... 59 

5.8 Importar un archivo de material .................................................................................. 61 

5.9 Exportar datos de medición ......................................................................................... 63 

6 Control remoto ........................................................................................................ 65 

6.1 TCP/IP ......................................................................................................................... 65 

6.1.1 Formato general de comandos y resultados ................................................................. 66 

6.1.2 Comando MEASURE ...................................................................................................... 67 

6.1.3 Comando GETCONFIGURATIONS .................................................................................. 68 

6.1.4 Comando GETCONFIGIDS .............................................................................................. 68 

6.1.5 Comando GETTHICKNESSBOUNDS ................................................................................ 69 

6.1.6 Comando STARTAUTOMATION (modo de automatización) ......................................... 70 

6.1.7 Comando STOPAUTOMATION (modo de automatización) ........................................... 70 

6.1.8 Comando TRIGGERAUTOMATIONSENSOR (modo de automatización) ........................ 70 

6.1.9 Comando GETAUTOMATIONSTATE (modo de automatización) ................................... 71 

6.1.10 Comando CREATESAMPLE (modo de automatización) ................................................. 71 

6.1.11 Comando GETNUMBEROFMEASUREMENTS ................................................................. 71 

6.1.12 Comando GETSERVICESTATUS ...................................................................................... 72 

6.1.13 Comando GETAMBIENTSENSORDATA (solo CoatMaster Inline) ................................... 72 

6.2 HTTP ........................................................................................................................... 74 

7 Mantenimiento / Servicio ........................................................................................ 75 

7.1 General ....................................................................................................................... 75 

7.2 Mantenimiento del software ....................................................................................... 75 



  Manual del usuario de CoatMaster 

  5/88 

7.2.1 Diagnóstico del software CoatMaster ........................................................................... 76 

7.2.2 Actualización del software integrado en CoatMaster ................................................... 77 

7.2.3 Restauración del software integrado en CoatMaster ................................................... 77 

7.3 Limpieza de ventana de medición ................................................................................ 78 

7.4 Rellenar el refrigerante ................................................................................................ 78 

7.5 Almohadillas de filtros ................................................................................................. 80 

7.5.1 CoatMaster .................................................................................................................... 80 

7.5.2 CoatMaster Inline .......................................................................................................... 80 

7.6 Medición de blanco ..................................................................................................... 80 

8 Resolución de problemas ......................................................................................... 81 

9 Datos técnicos ......................................................................................................... 82 

9.1 Hoja de datos CoatMaster ........................................................................................... 83 

9.2 Hoja de datos CoatMaster Inline .................................................................................. 84 

9.2.1 Información relevante de Dimensiones y Montaje del CoatMaster ........................... 855 

9.2.2 Información relevante de Dimensiones y Montaje del CoatMaster Inline ................. 866 

10 Transporte, embalaje, almacenamiento ............................................................... 877 

10.1 Inspección del transporte............................................................................................. 87 

10.2 Embalaje .................................................................................................................... 877 

10.3 Almacenamiento ......................................................................................................... 87 

 



Manual de uso de CoatMaster   

 

 

6/88  

1 General 

1.1 Información  

Este manual describe el CoatMaster y proporciona toda la información necesaria para su uso seguro y 
para mantenerlo en buenas condiciones de funcionamiento.  

Lea detenidamente este manual antes de instalar y hacer funcionar su sistema y preste especial 
atención a las precauciones de seguridad del capítulo 2. Guarde el manual en el entorno inmediato del 
instrumento, para que se pueda consultar en todo momento.  
 

Las imágenes de este manual sirven para comprenderlo de forma general y podrían desviarse del 

diseño real del producto. 

1.2 Acerca de este manual 

El Manual del Usuario contiene instrucciones sobre la correcta instalación, uso de CoatMaster, 
información de seguridad, así como el mantenimiento por parte del usuario y la resolución de 
problemas. En el Manual del Operario hay más información detallada disponible sobre la configuración 
de la red y la comunicación, la calibración, las aplicaciones y el control remoto externo. 

Los párrafos que comienzan con NOTA contienen información útil para trabajar con el 
dispositivo/software o con sus complementos. Las NOTAS no están relacionadas con ningún tipo de 
peligro o daño (véase el siguiente ejemplo).  

NOTA  
Consejos útiles para el manejo fácil del instrumento/software. 
 

1.3 Limitación de responsabilidad 

Se ha diseñado y construido este dispositivo de acuerdo con la tecnología de vanguardia actual. No 
obstante, pueden surgir riesgos para los usuarios, la propiedad y el medioambiente cuando se usa el 
dispositivo de manera descuidada o indebida.  

Winterthur Instruments ha determinado los siguientes peligros residuales derivados del dispositivo:  

 No se considera el Manual de instrucciones. 

 El dispositivo no se maneja de acuerdo con su uso debido.  

 El dispositivo es utilizado por personal con formación insuficiente.  

 Modificación no autorizada del dispositivo. 

 Uso de piezas de repuesto no incluidas en la lista. 

 
Las advertencias adecuadas de este manual sirven para alertar al usuario de los peligros residuales. 
 

Debido a diseños especiales, las opciones adicionales y las modificaciones técnicas más recientes, los 

contenidos reales de la entrega podrían desviarse de las descripciones e ilustraciones que se recogen 

aquí. 
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Se aplicarán las obligaciones acordadas en el contrato de entrega, los términos y condiciones 

generales, además de las condiciones de entrega del fabricante y las disposiciones legales vigentes 

en el momento del cierre del contrato. 

 

1.4 Copyright · Derechos de autor 

No se pueden realizar modificaciones técnicas al dispositivo sin el acuerdo previo por escrito de 
Winterthur Instruments. Las modificaciones no autorizadas pueden afectar a la seguridad del sistema 
o provocar accidentes.  
 

Este manual está protegido por derechos de autor. La información que contiene no se puede 

reproducir, distribuir ni usar con fines de competencia, ni poner a disposición de terceros. Asimismo, 

está prohibida la fabricación de cualquier componente con ayuda de este manual sin autorización 

previa por escrito.  

1.5 Condiciones de garantía 

Las condiciones de garantía son parte de los términos y condiciones generales del fabricante. 

 

El software se instala en el PC integrado en CoatMaster. Cualquier modificación o modificaciones del 

sistema del PC integrado, como por ejemplo 

 Instalación de software adicional 

 Actualizaciones de software 

pueden afectar o destruir el software de CoatMaster y, por consiguiente, están prohibidas. 

Winterthur Instruments no asume ninguna responsabilidad por la pérdida de datos en el PC 

integrado. Se recomienda encarecidamente realizar copias de seguridad de los datos del PC con 

regularidad (datos de aplicación y medición). 

1.6 Contenido de la entrega 

El contenido de la entrega de CoatMaster incluye: 

 CoatMaster 

 Cable de alimentación de 230V 

 2 antenas WLAN 

 Manual, Libro de mantenimiento 

 

El contenido de la entrega de CoatMaster Inline incluye: 

 Cabezal de medición de CoatMaster 

 Suministro de agua de CoatMaster (inserto en bastidor de 19“, 4 unidades de altura) 

 Suministro de corriente de CoatMaster (inserto en bastidor de 19“, 4 unidades de altura) 

 Cable de alimentación de 230V 

 Cable de conexión entre el cabezal de medición y el suministro de corriente de CM 

 Línea de señal Ctrl 1 entre el cabezal de medición y el suministro de corriente de CM 
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 Línea de señal Ctrl 2 entre el cabezal de medición y el suministro de corriente de CM 

 Cable ethernet entre el cabezal de medición y el suministro de corriente de CM 

 Cable de conexión entre el generador y el suministro de agua de CM 

 2 tubos de refrigerante entre el suministro de agua de CM y el cabezal de medición 

 Manual, Libro de mantenimiento 
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2 Seguridad 

Esta sección proporciona una visión general de todos los aspectos relacionados con la seguridad para 

una protección óptima del personal, además de un funcionamiento seguro y sin problemas. 

2.1 Responsibilidad del operario 

El operario es responsable de formar a su personal.  

El operador informará al fabricante sin demora de cualquier incidente relacionado con la seguridad 
que pudiera ocurrir durante el funcionamiento del dispositivo o de sus accesorios.  

Se pueden notificar las incidencias en la dirección de correo electrónico: 
info@winterthurinstruments.ch 
Se deben seguir estrictamente las disposiciones legales, tales como leyes locales, estatales y 

federales aplicables al dispositivo.  

2.2 Cualificación del usuario 

Antes de usar CoatMaster, se debe leer y comprender este manual.  
Solo pueden usar este dispositivo personas que, gracias a su formación o experiencia profesional, 

tengan una visión general de los peligros que pueden surgir durante el funcionamiento del 

dispositivo. 

2.3 Uso debido 

CoatMaster se ha diseñado exclusivamente para medir el grosor de los revestimientos. Se puede usar 

para los siguientes revestimientos: 

 

 Pintura en polvo sobre sustratos metálicos 

 Revestimientos adhesivos sobre sustratos metálicos 

 Revestimientos poliméricos sobre sustratos metálicos 

 Pintura húmeda sobre sustratos metálicos 

 Pintura húmeda (estado húmedo) sobre sustratos no metálicos 

 Revestimientos de pulverización térmica. 

 

Únicamente el personal formado puede manejar y limpiar el dispositivo. El uso debido también 

incluye el cumplimiento de este manual. Se deben respetar los intervalos de mantenimiento. 

2.4 Uso indebido 

Cualquier uso que no se haya mencionado anteriormente o que no cumpla con las especificaciones 
técnicas se considera uso indebido. El operario corre con todo el riesgo por cualquier daño causado 
por un uso indebido. Están prohibidos los siguientes usos:  

 Uso de CoatMaster en entornos donde puedan penetrar líquidos en la carcasa. 

 Introducción de cualquier objeto dentro de CoatMaster. 
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 Apertura de la carcasa de CoatMaster. Excepción: Limpieza o cambio de la almohadilla del 
filtro (véase el capítulo 7). Esto también es válido cuando CoatMaster no está conectado a la 
alimentación. Cuando CoatMaster está abierto, se anula la garantía y el fabricante rechaza 
toda responsabilidad. 

 Si sale líquido de CoatMaster, desenchufe de inmediato el dispositivo y póngase en contacto 
con el soporte técnico.  

 

Soporte técnico para CoatMaster +41 (0) 52 212 02 77, info@winterthurinstruments.ch)  

2.5 Advertencias y señales de seguridad usadas en este manual 

2.5.1 Descripción de las advertencias de seguridad 

PELIGRO, ADVERTENCIA, PRECAUCIÓN y AVISO son palabras de aviso estandarizadas para identificar 
niveles de gravedad del peligro de los riesgos relacionados con lesiones personales y daños 
materiales. Todas las palabras de aviso relacionadas con lesiones personales van acompañadas de la 
señal de seguridad general.  

¡Por su seguridad, es importante que lea y comprenda completamente la tabla que aparece a 
continuación con las distintas palabras de aviso y sus definiciones! 

Señal Palabra de 
aviso 

Definición Nivel de 
riesgo 

 

 

PELIGRO Indica una situación peligrosa que, si no se evita, 
provocará la muerte o una lesión grave.  
 

     

 

 

ADVERTENCIA Indica una situación peligrosa que, si no se evita, 
podría provocar la muerte o una lesión grave.  
 

    

 

 

PRECAUCIÓN Indica una situación peligrosa que, si no se evita, 
podría provocar una lesión moderada o leve.  
 

   

 AVISO Indica un posible daño material, pero no prácticas 
relacionadas con lesiones personales.  

 

 

Los símbolos de información de seguridad suplementaria pueden estar situados en un panel 
rectangular a la izquierda de la palabra de aviso y del texto complementario (véase el ejemplo). 

 

 

 

PELIGRO 

Texto suplementario, describe el peligro/riesgo (ej. explosión). Resultado del peligro 
si no se evita (ej. muerte). 
1. Lista de medidas para evitar el peligro o situación peligrosa descrita. 

 

 

mailto:nils.reinke@winterthurinstruments.ch
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2.5.2 Símbolos utilizados 

La lista de referencia que aparece a continuación incluye todos los símbolos de información de 
seguridad que se usan en este manual o en el dispositivo, además de su significado. 

 

Símbolo Significado 

 

Peligro general 

 

Daño del dispositivo 

 

Peligro eléctrico 
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2.6 Seguridad del producto 

Se ha diseñado y construido este dispositivo de acuerdo con la tecnología de vanguardia actual. No 
obstante, pueden surgir riesgos para los usuarios, la propiedad y el medioambiente cuando se usa el 
dispositivo de manera descuidada o indebida.  

Winterthur Instruments ha determinado los siguientes peligros residuales derivados del dispositivo:  

 El dispositivo es utilizado por personal con formación insuficiente.  

 El dispositivo no se maneja de acuerdo con su uso debido. 
 

Las advertencias adecuadas de este manual sirven para alertar al usuario de los peligros residuales. 

2.6.1 Peligros generales 

Los siguientes mensajes de seguridad muestran peligros de tipo general que pueden darse durante el 
manejo del dispositivo. El usuario deberá cumplir todas las contramedidas enumeradas para alcanzar 
y mantener el menor nivel posible de peligro.  
Se pueden encontrar mensajes de advertencia adicionales siempre que las acciones y situaciones 
descritas en este manual estén relacionadas con peligros situacionales. 

 

 

 

PRECAUCIÓN 

Fuente de luz integrada. El contacto visual directo puede producir problemas visuales. 

Nunca mire directamente a la fuente de luz. 

Para el uso de CoatMaster dentro de un entorno de proceso, recomendamos construir una 
cubierta óptima alrededor de la fuente de luz para absorber el impulso luminoso, de modo que 
no tenga impacto más allá del área de medición. Se pueden usar, por ejemplo, láminas 
metálicas reflectantes u oscurecidas para este fin. 

 

2.6.2 Elementos de seguridad integrados 

Hay un fusible de fusión lenta de 12,5 A integrado en CoatMaster como protección ante la 

sobretensión. 
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3 Interfaces de hardware de CoatMaster 

3.1 CoatMaster  

 

 
Figure 1. CoatMaster 3D CAD illustration 

 

 
Figure 2 CoatMaster frontal view (left) and side view (right) 

 
 

 
Figure 3 CoatMaster connections - Rear view 

1 ON/OFF interruptor  
2 Conexión de alimentación  
 

3 Conexión USB por WIFI 
4 Ethernet conexión 
5 Conexión del sensor para la sincronización externa  
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3.2 CoatMaster Inline 

 
 

 
Figure 4. 3D CAD illustration of the CoatMaster in-line measurement and sensor head 

 

  
Figure 5. Frontal (left) and side view (right) of the CoatMaster in-line measurement and sensor head 
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Figure 6. CoatMaster Inline - measurement optics rear view 
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Figure 7. CoatMaster Inline - Control (top) and Cooling (bottom) units 
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Figure 8. CoatMaster Inline - Control (top) and Cooling (bottom) units - front view 

 

 

 
Figure 9. CoatMaster Inline - Control (top) and Cooling (bottom) units  - rear view 
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4 Instalación del sistema 

NOTA 
Inspeccione el dispositivo en busca de daños al desembalarlo. Acepte los paquetes dañados 
únicamente con reservas por posibles daños. Deje constancia por escrito de esta reserva en la nota de 
entrega. Informe de inmediato al transportista y al remitente y no desembale el paquete hasta que 
haya recibido una notificación del remitente. 

Conserve el material de embalaje original para transportes futuros. 

4.1 Instalación del hardware 

 Coloque el equipo sobre una superficie limpia, estable, regular y horizontal. Tenga en cuenta 

las dimensiones máximas del equipo, el peso y las condiciones operativas que se describen 

en el capítulo 3.1. 

 No coloque ningún objeto encima ni debajo del equipo. 

 Debe dejarse una distancia mínima de 20 cm entre el equipo y cualquier otro objeto o la pa-

red para garantizar una ventilación suficiente. 

 Conecte el equipo a la corriente mediante el cable de alimentación incluido en la entrega. 

 

 

 

 

ADVERTENCIA 

Riesgo de descarga eléctrica. Puede ocasionar lesiones graves o incluso la muerte. 

Comprobar la debida conexión a tierra antes del uso. Sustituir de inmediato el cableado si está 
defectuoso.  

 

 

 

 

 

PRECAUCIÓN 

Fuente de luz integrada. El contacto visual directo puede provocar trastornos visuales. 

Nunca mire directamente a la fuente de luz. 

Para usar el CoatMaster en un entorno de proceso, recomendamos colocar una cobertura óp-
tica alrededor de la fuente de luz para absorber el impulso de luz y que no tenga un impacto 
fuera de la zona de medición. P.ej. Pueden utilizarse chapas metálicas oscurecidas para ello. 

 

 

NOTA   
Para desconectar la alimentación en caso de emergencia desenchufando la corriente, el acceso al en-
chufe no debe estar obstruido por el equipo u otros objetos. 

 

 

 

AVISO 

Riesgo de falsa alarma de detectores de incendio. Los detectores de incendio no compatibles 
podrían dispararse a causa del impulso de luz del CoatMaster. 

En las habitaciones donde se utilice el CoatMaster, utilice detectores de incendios compatibles 
con doble sensor de UV/IR (por ejemplo los de la empresa STS Brandschutzsysteme GmbH). 
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AVISO 

Daños al instrumento por instalación incorrecta. Instalar el equipo con un ángulo de inclina-
ción incorrecto podría motivar el sobrecalentamiento del equipo. 

Cuando se instale el equipo en ángulo vertical, no debe superarse un ángulo de 30°. Cuando se 
instale el equipo en ángulo horizontal, no debe superarse un ángulo de 90°. 

 

 

 

 

 

AVISO 

Riesgo de error del equipo por huellas dactilares en la lente. La contaminación de la lente po-
dría provocar errores de medición. 

No toque nunca la lente directamente. Limpie la lente y la ventana de medición como se in-
dica en el capítulo 7.2. 

 

 

4.2 Requisitos de software 

El CoatMaster puede utilizarse mediante tres entornos de software diferentes: 

 

Sistema operativo CoatMaster: Permite iniciar mediciones, crear aplicaciones, exportar los datos de 

medición, visualizar los valores y estadísticas de medición. La creación de aplicaciones y la exporta-

ción de los datos de medición solo puede realizarse con el CoatMaster Desktop. El software debe ins-

talarse en un ordenador con Windows.  

Requisitos del sistema: 

 Sistema operativo: Windows 10, 64 bits 

 Procesador: 2,4 GHz 

 Memoria de trabajo: 4 GB 

 Espacio disponible en el disco duro: 300 MB 

 Resolución de la pantalla: 1024 x 768 ppp 

CoatMaster Web Client: Permite iniciar mediciones, visualizar los valores de medición, definir los 

ajustes de red y administrador, instalar actualizaciones de software. La definición de los ajustes de 

red y administrador, así como la instalación de las actualizaciones de software, solo es posible con el 

Web Client. 

Requisitos del sistema: 

 Navegador web  
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Control remoto: Permite medir a través de la interfaz TCP/IP. Esta interfaz se utiliza para activar me-

diciones y para transferir los valores de medición. Ejemplos: Sistemas PLC como Siemens S7 o Be-

ckhoff TwinCAT. 

Antes de poder medir con el Cliente web de CoatMaster o a través del control remoto, debe crearse 

una aplicación correspondiente con el software CoatMaster Desktop. Esto se describe en el capítulo 

¡Error! No se encuentra el origen de la referencia.. 

4.3 Interfaz para conectar al ordenador de control 

Para poder manejar el CoatMaster, el ordenador debe conectarse mediante un cable Ethernet al 

CoatMaster. 

 

4.4 Ajustes de red y administrador 

Asegúrese de que el CoatMaster esté correctamente instalado, como se describe en el capítulo 0 

NOTA 

Inspeccione el dispositivo en busca de daños al desembalarlo. Acepte los paquetes dañados 

únicamente con reservas por posibles daños. Deje constancia por escrito de esta reserva en la nota de 

entrega. Informe de inmediato al transportista y al remitente y no desembale el paquete hasta que 

haya recibido una notificación del remitente. 

Conserve el material de embalaje original para transportes futuros. 

Instalación del hardware y enciéndalo. Haga lo siguiente para configurar la red e instalar el software: 

1. Configure el acceso a la red del CoatMaster como se describe en el capítulo ¡Error! No se en-

cuentra el origen de la referencia.. 

2. Instale el sistema opreativo CoatMaster al menos en un ordenador con Windows, como se 

describe en el capítulo 4.4.2. El sistema operativo CoatMaster es necesario para crear aplica-

ciones CoatMaster. 

4.4.1 Configurar la red del CoatMaster con CoatMaster Web Client 

Asegúrese de que el CoatMaster y el ordenador operativo estén conectados con un cable Ethernet. 

La dirección IP del CoatMaster se indica en el libro de servicio CoatMaster, que forma parte de la en-

trega. Haga lo siguiente si desea modificar la configuración de red (dirección IP, máscara de red, pa-

sarela de acceso): 

 

1. Abra un navegador web, escriba la dirección IP del CoatMaster (por ejemplo 

“192.168.1.140”) en el campo de URL y confirme con Intro.  

El navegador web se conecta con el CoatMaster y abre la ventana principal del CoatMaster 
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Web Client. En caso necesario, cambie el idioma con el botón  en la parte superior de-

recha. 

 

Figura 10. Página de inicio del Web Client 

 

2. Haga clic en la línea Administrator y conéctese con el usuario admin y la contraseña admin.  

3. En la ventana de red puede definir la dirección IP para la conexión Ethernet, la SSID (nombre) 

de la WLAN y la contraseña de la WLAN. La SSID puede ocultarse, en caso necesario. En tal 

caso, desactive la casilla de verificación On. Haga clic en Save (Guardar). Nota: no se 

permiten las direcciones de subred 192.168.139.XXX y 109.198.7.XXX.

 

Figura 11. Ajustes del administrador en el Web Client 
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Introduzca aquí los datos para tenerlos disponibles para usarlos después: 

 

N.º de serie del 

CoatMaster: 

 

SSID de la WLAN:  

Contraseña de la 

WLAN: 

 

Dirección IP de la 

Ethernet: 

 

 

 

Si pierde los datos de conexión, informe a su administrador. Después de haber modificado los ajustes 

de red, reinicie el CoatMaster (apague el interruptor principal, espere 10 segundos y vuelva a encen-

der el equipo).  

4.4.2 Instalar el software CoatMaster Desktop 

Asegúrese de que el CoatMaster y el ordenador operativo estén conectados con un cable Ethernet. 

La dirección IP del CoatMaster se indica en el libro de servicio CoatMaster, que forma parte de la en-

trega. 

1. Abra un navegador web, escriba la dirección IP del CoatMaster (por ejemplo 

“192.168.1.140”) en el campo de URL y confirme con Intro.  

 

Figura 12. Ventana de descarga en el cliente web 

 

2. Haga clic en Download (Descargar). Se abre el submenú Downloads (Descargas). Haga clic en 

“CoatMaster.Operating.System.17.1.Grand.Combin” para descargar el software del sistema 

operativo CoatMaster. Se muestra el mensaje Show all downloads (Mostrar todas las descar-

gas) en la ventana del navegador (la posición y el mensaje específico dependen del tipo de 

navegador web). Al hacer clic en el texto se abre una lista de las últimas descargas (la vista 

depende del tipo de navegador web). 

3. Extraiga el contenido del archivo ZIP descargado en su ordenador (clic con el botón derecho 

del ratón en el archivo ZIP). Después puede borrar el archivo ZIP. 
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4. El archivo extraído contiene la carpeta CoatMaster.Operating.System.17.1.Grand.Combin 

con el archivo ejecutable “CoatMaster Operating System 17.1.exe”. Cree un enlace a “Coat-

Master Operating System 17.1.exe” y cópielo en el escritorio para poder acceder a él fácil-

mente. 

5. Ejecute el software CoatMaster Operating System 17.1 haciendo doble clic en el icono. En la 

barra de menú, seleccione Configuration → Preferences (Configuración → Preferencias). En el 

cuadro de diálogo Preferences (Preferencias) seleccione Server (Servidor).  

 

 

Figura 13. Ajustes del servidor en el programa independiente CoatMaster 

 

6. En el campo Host or IP address (Nombre o dirección IP) escriba al dirección IP del CoatMaster 

(ver el capítulo 4.4.1). 

7. Conecte el ordenador y el CoatMaster mediante un cable Ethernet. Haga clic en Test server 

connection (Probar conexión con el servidor) para asegurarse de que pueda establecerse la 

conexión. Si falla la prueba de conexión con el servidor, revise la dirección IP y la conectivi-

dad Ethernet. 

 

Para cambiar la dirección IP de la Ethernet, proceda como se describe en el capítulo 4.3.1. 

4.4.3 Seleccionar el idioma 

Inicie el CoatMaster Operating System haciendo doble clic en el icono. Si el software no se muestra 

en el idioma que desea, seleccione Configuration > Language (Configuración > Idioma). 

Aparece un submenú con los idiomas disponibles. Seleccione el idioma correspondiente con un clic. 

Aparece un cuadro de diálogo indicándole que reinicie el software. Confirme con Aceptar y reinicie el 

software. El programa se abrirá ahora en el idioma seleccionado. 
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4.4.4 Definir los ajustes del administrador en el sistema operativo 

En la pestaña Administrator, el administrador del software puede deshabilitar la edición y borrado de 

aplicaciones para los usuarios.  

 
Figura 14. Ajustes del administrador en el software independiente CoatMaster 

 

 

 

Para modificar los ajustes, haga clic en Login (Conectar).  Aparece un cuadro de diálogo de conexión. 

Contraseña del administrador: admino041. Haga clic en Aceptar. El campo Application editable/dele-

table (Aplicación editable/borrable) se vuelve activo. Ahora podrá habilitar o deshabilitar la edición y 

borrado de aplicaciones activando o desactivando la casilla de verificación. La función hace referen-

cia a crear una nueva aplicación, borrar, copiar, cambiar de nombre o editar una aplicación existente 

y borrar los valores de medición de la zona de tendencias.  
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5 Medición del espesor con CoatMaster 

5.1 Principio de medición 

El CoatMaster funciona según el principio de las pruebas térmicas de recubrimientos. De este modo, 
la superficie de revestimiento se calienta por medio de un impulso de luz. Después del calentamiento 
inicial de unos pocos grados, la superficie se enfría a medida que el calor se difunde en áreas más 
profundas del recubrimiento y el sustrato. La evolución en la superficie depende de las propiedades 
físicas del recubrimiento. Cuanto más delgado sea el recubrimiento (dado que tiene una conductivi-
dad térmica más baja que el sustrato), más rápidamente disminuye la temperatura superficial. 
 

 
Figure 15 Schematic diagram of Thermal Testing of Coatings 

 

5.2 CoatMaster aplicación en superficies rugosas 

 

Para superficies rugosas se recomienda utilizar un método de referencia como el pesaje o múltiples 

medidas de sección transversal microescópicas para equilibrar la gran variación en los resultados de 

espesor mediante análisis de sección transversal. Con un método de referencia de contacto (por 

ejemplo sondas electromagnéticas o micrométricas), la rugosidad de la superficie reduce 

drásticamente la repetibilidad de las mediciones de espesor. Un punto de medición grande del 

CoatMaster reducirá la dependencia de la colocación inexacta de la pieza. 
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5.3 Medición con el CoatMaster Operating System 

El CoatMaster Operating System debe instalarse en un ordenador con Windows para realizar aplica-
ciones y ejecutar mediciones manuales y automatizadas. Encienda el CoatMaster y después de un 
minuto conecte el ordenador con el CoatMaster por ethernet: 

 Ethernet: Conecte el ordenador y el CoatMaster con Ethernet. Esto es posible ya sea por 

conexión directo con un cable o mediante la integración del CoatMaster en su red local. 

 WIFI: Si se ha instalado un dongle WIFI opcional de acuerdo con las directrices 

proporcionadas por Winterthur Instruments, se puede acceder al CoatMaster insertando el 

SSID y la contraseña proporcionados. Póngase en contacto con su administrador si no conoce 

el SSID (nombre) o la contraseña. 

Tras conectar con CoatMaster, inicie el CoatMaster Operating System. Se abre la ventana principal 
(vea Figure 16).  
 

 
 
Figure 16 La ventana principal CoatMaster Operating System se divide en cinco zonas: 1. Menu, 2. Aplicaciones, 3. 
Mediciones, 4. Estadísticas y 5. Tendencias (vea capítulo 5.5.3 en la página 46 para establecer los límites de advertencia y 
error. 

 
Nota: 
Para restablecer la vista principal por defecto como se muestra en Figure 16 La ventana principal CoatMaster Operating 
System se divide en cinco zonas: 1. Menu, 2. Aplicaciones, 3. Mediciones, 4. Estadísticas y 5. Tendencias (vea capítulo 5.5.3 
en la página 46 para establecer los límites de advertencia y error. 

, seleccione Window > Reset window en la zona del Menú (1). 
 

2 

1 
4 

5 

3 
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Para comprobar si el software de CoatMaster Desktop Client está conectado a CoatMaster, proceda 

de la siguiente manera: 
En la barra de menú (véase Figure 16 La ventana principal CoatMaster Operating System se divide en cinco zonas: 1. Menu, 
2. Aplicaciones, 3. Mediciones, 4. Estadísticas y 5. Tendencias (vea capítulo 5.5.3 en la página 46 para establecer los límites 
de advertencia y error. 

1. ), seleccione Preferences > Server. 

2. En caso de conexión WLAN, introduzca 10.10.0.1 en el campo Host or IP address. En caso de 

conexión Ethernet, introduzca la IP que le haya especificado su administrador. 

3. Pulse el botón Test server connection. Si el software muestra el mensaje Server test 

successful, entonces puede seguir trabajando con CoatMaster Desktop Client. Por el 

contrario, Server test failed indica que no hay conexión. En este caso, compruebe el 

hardware y la configuración del software. 

 

Para efectuar mediciones, seleccione primero el formulario desde la zona de la Aplicación (2). Si no 

hay una aplicación apropiada disponible, puede crearla como se describe en el capítulo ¡Error! No se 

ncuentra el origen de la referencia.. Si la aplicación está deshabilitada, aún no está completa pero 

requiere información adicional de usted. 

5.3.1 Medición manual 

Para iniciar una medición manual, véase la zona Medición (3) en 16: 

 

 

 
Figure 17. Measurement results window in the stand-alone software 

 

La medición se inicia al hacer clic en el botón Medición . 
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El resultado de la última medición se muestra en las unidades definidas (p. ej. µm). 

 

La zona de Estadísticas (4) contiene valores estadísticos tales como la media, la desviación media, 

etc., que se calculan en base a todas las mediciones del bloque seleccionado actualmente. Los 

bloques son colecciones de mediciones definidas por el usuario. Si realizan mediciones en varios 

puntos, puede usar por ejemplo un bloque nuevo para cada posición de medición para ver los 

valores medios en cada posición. Todas las aplicaciones se crean con el bloque Default. Para crear un 

bloque nuevo, pulse el botón . Las mediciones nuevas se almacenarán en el bloque seleccionado 

actualmente.  

 

En la zona Tendencias (5) se muestran los últimos valores de medición de un bloque, ordenados de 

acuerdo con el tiempo de medición. En esta zona se visualizan las tendencias, como el aumento o la 

disminución sistemáticos del grosor del revestimiento. Se puede dibujar una ventana de zoom con el 

ratón para aumentar la resolución. Al hacer clic con el botón derecho, se borran puntos de datos 

individuales.  

 

Resumen de funciones en la zona de Medición: 

 

 

 

 

Iniciar medición 

 

Inicia la medición 

 

 
 

 

Añadir bloque  

 

Disminuye el número automáticamente y al 

mismo tiempo añade un bloque nuevo 

 

 

 

Gestionar muestras 

 

Abre el diálogo gestionar muestras 

 

 

 

Exportar mediciones 

 

Exporta el contenido de la aplicación actual, 

mediante File > Export 

 

 

 

Modo automático 

 

Cambia la vista al modo automático (véase el 

capítulo ¡Error! No se encuentra el origen de la 

eferencia.). 
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5.3.1.1 Gestionar bloques 

Un bloque es una colección de valores de medición. Mediante el botón  en la zona de bloques, 

se pueden borrar y exportar bloques.  

 

 
Figure 18. Block management in the stand-alone software 

 

Resalte un bloque y haga clic en "Delete" para borrar un bloque o en "Block export" para exportar los 
valores del bloque desde CoatMaster hasta su ordenador. Consulte el capítulo ¡Error! No se encuen-
tra el origen de la referencia.9 para más información sobre la exportación de datos. Haga clic en OK 
para guardar la configuración y cerrar el diálogo. Haga clic en Cancel para cerrar el diálogo sin 
guardar.  
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5.3.2 Medición automática con sensor externo 

En el modo automático del software CoatMaster Desktop, se dispara la medición mediante un sensor 

externo. El sensor tiene que estar conectado a CoatMaster, como se describe a continuación. Esta 

función permite la medición automatizada, por ejemplo dentro de una línea de producción. En 

cuanto el sensor detecta una pieza, se pueden disparar una serie de mediciones de CoatMaster. 

 

Los valores de medición se almacenan en CoatMaster. Hay tres posibilidades para visualizar los 

valores de medición que se generan en el modo automático: 

 

1. Exportar los valores de medición a su ordenador mediante el Operating System software, donde 

se podrán tratar posteriormente con otro software (ej. Excel) (vea capítulo 5.9). 

2. Display the measurement values live with the CoatMaster Desktop software (see chapter 

5.3.2.2). 

3. Visaulizar los valores de medición en directo en una visualización complativle con WLAN (ej. a 

tablet or a monitor) con el CoatMaster Web software (véase el capítulo 5.4.1). 

 

5.3.2.1 Conexión al sensor externo 

The sensor externo está conectado al CoatMaster mediante una interfaz estándar de 15 V 

proporcionada con un conector XLR (véase Figure 19). 

 

La conexión del sensor tiene la siguiente asignación de pines: 

 
Figure 19 Conector XLR-3f para sensor externo: 1 puesta a tierra, 2 suministro +15V, 3 señal. 

5.3.2.2 Inicio y parada de las mediciones automáticas con CoatMaster Operating System 

 

Inicie el modo automático haciendo clic en el icono  en la barra superior de la zona de Medición (3) de la ventana 
principal (véase Figure 16 La ventana principal CoatMaster Operating System se divide en cinco zonas: 1. Menu, 2. 
Aplicaciones, 3. Mediciones, 4. Estadísticas y 5. Tendencias (vea capítulo 5.5.3 en la página 46 para establecer los límites de 
advertencia y error. 

16). La vista de la pantalla cambia a la vista automática, véase 20. 
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Figure 20 Vista automática del CoatMaster Operating System 

 

Para iniciar el modo automático, seleccione una configuración de automatización (arriba a la 

izquierda) y una aplicación de medición (abajo a la izquierda), después pulse el botón .  

La vista cambia a la vista automática activa. 
Las mediciones se mostrarán en la zona Tendencias (¡Error! No se encuentra el origen de la referencia.). En la línea de 
stado (abajo) se muestra el estado del sensor (sondeo o medición). Para cambiar la configuración o la aplicación, detenga 

el modo automático pulsando el botón . Para volver a la vista de medición estándar (Figure 16 La ventana 
principal CoatMaster Operating System se divide en cinco zonas: 1. Menu, 2. Aplicaciones, 3. Mediciones, 4. Estadísticas y 5. 
Tendencias (vea capítulo 5.5.3 en la página 46 para establecer los límites de advertencia y error. 

10), pulse el botón . 

 

5.3.2.3 Crear y editar una configuración automatizada 

 

Prepare una configuración automatizada editango una configuración existente (haga click con el 

botón derecho en la configuration name > “Edit configuration”) o añadiendo una nueva 

configuración con el botón   en la ventana de Configuración. Edite las propiedades de 

automatización para adaptarlas a su aplicación: 
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Figure 21. Setting for automation in the stand-alone software 

 

Automation name: Nombre para esta configuración que se mostrará en la vista de automatización. 

Polling frequency sensor signal (ms): Intervalo del tiempo para comprobar la señal del sensor. Dis-
minuya este valor para adaptarse a objetos que se muevan rápidamente. Por ejemplo, un objeto con 
una velocidad de 40 m/min se moverá 3.3 cm en 50ms. Si el punto de medición tiene que colocarse 
con mayor precisión, disminuya el intervalo de sondeo en consecuencia. 
Delay between sensor trigger and first measurement(ms): Ajuste este tiempo para ajustar el re-
tardo entre el disparo del sensor y la primera medición. 
Number of measurements after sensor trigger: Ajuste el número de mediciones consecutivas a eje-
cutar después del disparo del sensor. 
Wait between two measurements (ms): Retardo entre mediciones consecutivas. 
Measure time-out (ms): Retardo de tiempo después de la medición hasta que se muestre un error 
de tiempo de espera 
Measurement all n sensor triggers: Establezca este número mayor a uno si desea omitir objetos que 
son detectados por el sensor. Por ejemplo, un valor de 3 activará medidas para cada tercer objeto 
solamente (saltando dos objetos). 
 

Ok: mantener los cambios. 

Cancel: descartar cambios. 
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Resumen de funciones de la vista automática: 

 

 
 

 

Iniciar 

automatización 

 

 

Iniciar modo automático 

 

 
 

 

Detener 

automatización 

 

 

Detener modo automático 

 

 
 

 

Cerrar 

automatización 

 

Cerrar el modo automático y regresar a la ventana principal 

 

 
 

 

Icono de advertencia 

 

 

Se muestra al lado del valor de medición cuando se desvía de 

forma significativa de la aplicación usada 

 

 
 

 

Icono de error 

 

Se muestra al lado del valor de medición cuando se desvía 

demasiado de la aplicación usada 

5.3.3 Estadísticas de medición 

La zona de Estadísticas (4) de la vista principal de CoatMaster Operating System (Figure 16) contiene 

información estadística detallada sobre los datos de medición en el bloque seleccionado 

actualmente. Figure 22 muestra un ejemplo de análisis estadístico de los datos del bloque. 

 
Figure 22 Información estadística del bloque de datos seleccionado actualmente. 
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�̅� : valor medio 

σ: desviación estándar 

Min: valor mínimo en el bloque de datos 

Max: valor máximo en el bloque de datos 

N(#): número de mediciones en el bloque de datos 

N below: número de mediciones por debajo del límite de tolerancia inferior 

N above: número de mediciones por encima del límite de tolerancia superior 

5.3.4 Advertencias y Errors 

Las advertencias y errores se muestran en la zona de Medición (3) de la vista principal (16). La 

siguiente tabla enumera los iconos de advertencia y error para CoatMaster: 

 

 

 

 

Medición con icono 

de advertencia 

 

 

Indica una posible desviación de la medición actual respecto a 

los datos de la aplicación. 

 

 

 

Medición con icono 

de error 

 

 

Indica una fuerte desviación de la medición actual respecto a 

los datos de la aplicación. 

 

 

 

Icono de 

notificación 

Hay que realizar el 

mantenimiento 

pronto 

 

 

Se deberá realizar el mantenimiento del dispositivo pronto. 

Informe a su contacto de ventas para organizar el ciclo de 

mantenimiento. Tenga disponibles los datos de la pantalla Help 

> About this CoatMaster (véase el capítulo ¡Error! No se en-

cuentra el origen de la referencia.). 

 

 

 

Icono de 

notificación 

Hay que realizar el 

mantenimiento. 

 

 

Hay que realizar el mantenimiento del dispositivo. El manejo de 

CoatMaster sin mantenimiento reduce la vida útil, causa un 

deterioro de la precisión y aumenta el riesgo de fallo. Informe a 

su administrador para organizar el mantenimiento 

inmediatamente. Tenga disponibles los datos de la pantalla 

Help > About this CoatMaster (véase el capítulo ¡Error! No se 

ncuentra el origen de la referencia.). 

 

Measurement 

warning range  

Indicates that a user-specified number of consecutive 

measurement values lie in the warning range (see description 

of Display setting for new applications in chapter 5.5 Crear 

nuevas aplicaciones CoatMaster ). 

 

Measurement error 

range  

Indicates that a user-specified number of consecutive 

measurement values lie in the error range (see description of 
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Display setting for new applications in chapter 5.5 Crear nuevas 

aplicaciones CoatMaster ). 

En la configuración Expert en la pestaña Evaluation, los campos Warning y Error enumeran el valor 

umbral correspondiente que marca el límite para un mensaje de advertencia o de error (que califica 

a una medición rutinaria posterior como fallida), cuando el valor de medición se desvía demasiado de 

la aplicación usada. En caso de advertencia, se muestra el icono de advertencia en la ventana 

principal, junto al valor de medición; en caso de error se muestra el icono de error. 

 

En CoatMaster Inline están disponibles los siguientes iconos: 

 

 

 

Icono de 

advertencia 

Temperatura 

del refrigerante 

 

La temperatura del refrigerante es alta. Espere hasta que el signo 

desaparezca para realizar más mediciones. 

 

 

 

Icono de error 

Temperatura 

del refrigerante 

 

La temperatura del refrigerante es demasiado alta, pueden darse 

daños en el sistema de CoatMaster. Apague CoatMaster y póngase 

en contacto con su administrador. 

 

 

 

Icono de 

advertencia 

Caudal del 

refrigerante 

 

El caudal del refrigerante es demasiado bajo. Asegúrese de que los 

tubos del líquido refrigerante están dispuestos de tal manera que 

se asegure un flujo de líquido libre. 

 

 

 

Icono de error 

Caudal del 

refrigerante 

 

El caudal del refrigerante es críticamente bajo, es posible que se 

den daños en el sistema de CoatMaster. Apague CoatMaster y 

póngase en contacto con su administrador. 

 

 
 

 

Icono de 

advertencia 

Nivel de 

refrigerante 

 

El nivel de refrigerante es demasiado bajo. Rellene el líquido 

refrigerante (véase el capítulo 04). 

 

 

 

Icono de error 

Nivel de 

refrigerante 

 

 

El nivel del refrigerante es críticamente bajo, es posible que se den 

daños en el sistema de CoatMaster. Rellene el líquido refrigerante 

de inmediato (véase el capítulo 7.4). 

 

 

 

Icono de error 

Conexión con el 

servidor / 

cliente fallida 

 

 

Se ha detectado una incompatibilidad de software (conexión con el 

servidor / cliente fallida). Actualice el software desde CoatMaster 

(véase el capítulo 4.4.2.). 



Manual de uso de CoatMaster   

 

 

36/88  

 

 

 

 

 

AVISO 

Riesgo de sobrecalentamiento. Si hay demasiado poco refrigerante o está demasiado 
caliente, se puede provocar un sobrecalentamiento del instrumento. 

Reaccione a la aparición del icono de advertencia o error correspondiente de inmediato. Para 
más detalles sobre la medida de corrección. 

 

 

En la zona de Medición, se muestra en la unidad definida el resultado de la última medición y el valor 

medio sobre una cantidad definida de los últimos valores de medición. 

 

5.3.5 Información del sistema 

Para mostrar la información sobre la versión del software y el estado del hardware, pulse Help > 

About this CoatMaster en la zona del Menú (1) del CoatMaster Desktop ventana principal (Figure 16).  

 
Figure 23. System information in the stand-alone software 

  

Estado de la fuente de luz: Indica la cantidad de uso de la fuente de luz (100 % - fuente de luz nueva, 

0 % - es necesario sustituir la fuente de luz). Póngase en contacto con su administrador para sustituir 

la fuente de luz. 

Próxima revisión en: Muestra el número de días hasta el próximo ciclo de mantenimiento y revisión 

previsto.  

 

Se debe hacer una revisión de CoatMaster una vez al año o cuando la fuente de luz llegue al 0 %. El 

manejo de CoatMaster después de alcanzar cualquiera de los límites reduce la vida útil, causa un 

deterioro de la precisión y aumenta el riesgo de fallo. Informe a su administrador para planificar el 
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ciclo de mantenimiento inmediatamente. 

Pulse OK para cerrar esta ventana. 

5.3.6 Ventanas opcionales para menú principal 

Las áreas visibles en la ventana principal se pueden definir mediante el menu Window > Show View. 

 
Figure 24. Selección de posibles ventanas y fichas (tabs) visualizadas  

 

Para mostrar un área nueva en la ventana principal, resalte la entrada correspondiente y haca click 

en OK. 

 

Para resetear menú principal a su configuración original, select Window > Reset Window. 

Se mostrarán las áreas de Aplicaciones, Medidas, Estadísticas y Tendencias de la Aplicación 

seleccionada. 

 

NOTA · ADVERTENCIA 

Haciendo click en el botón derecho del ratón esta disponible el submenu que permite definir las 

propiedades de gráficos, guardar e imprimir, ampliar y reducir, definir un rango automático, exportar 

el gráfico y eliminar. 

 
Estas ventanas tienen los siguientes nombres y funciones: 
 

Last: Muestra el último valor medidor. 

Automation Log: Registro de todos los datos de control de automatización. 

Data Chart: Muestra las señales de medición como curvas de tiempo. 

Data: Muestra las señales de medición en forma de tabla numérica. 

Device Log: Se utiliza sólo para operaciones de servicio. 
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Test: Para llevar a cabo una prueba / ensayo del dispositivo, p.ej. una cantidad definida de 
mediciones sucesivas. 
Workspace: Utilizado sólo para operaciones de servicio. 

5.3.6.1 Test 

5.3.6.2 Estado 

Para el CoatMaster Inline, hay una ventana de estado del hardware que muestra la temperatura, 

flujo y el nivel del líquido refrigerante. 

 

 
Figure 25. Status window showing sensor data in the stand-alone software 

  

Valor umbral para las advertencias: 

 

Temperatura: 40 °C 

Caudal de refrigerante: 2 l/min 

Nivel de refrigerante: 20 % 

 

Valor umbral para los errores (ya no es posible la medición): 

 

Temperatura: 60 °C 

Caudal de refrigerante: 1l/min 

Nivel de refrigerante: 10 % 

 
Nota: 
To restore the factory main view as shown in Figure 16 select Window > Reset window from the 
Menu area (1). 
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5.4 Medición con el Web Client  

Conecte su ordenador con el CoatMaster e inicie el software Web Client como se describe en el capí-

tulo 4.4.1. Aparece la pantalla siguiente: 

 

 
Figura 26. Página de inicio del Web Client 

 

Haga clic en Measure (Medir), aparece un diálogo de selección con todas las aplicaciones guardadas 

en el CoatMaster: 

 

 
Figura 27. Seleccionar la aplicación en el Web Client 

 

Haga clic en la fila con la aplicación que desea usar para la medición. Si la aplicación correspondiente 

no está disponible, debe crearse primero (ver el capítulo ¡Error! No se encuentra el origen de la refe-

rencia.). 
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Figura 28. Ventana de medición en el Web Client 

 

Inicie la medición pulsando en Start measurement (Iniciar medición). El valor medido se traza en el 

diagrama de curva y se muestra sobre el diagrama en la unidad seleccionada. 

La zona gris del diagrama indica el rango de tolerancia. La zona roja a ambos lados indica la parte 

fuera del rango de tolerancia. El rango de tolerancia se define en la aplicación. La línea de puntos ne-

gros en el centro muestra el valor medio. 

 

El valor medio (Avg.), la desviación estándar (Std. dev.) y el número de mediciones realizadas (N) se 

muestran a la derecha sobre el diagrama de curva. Al pulsar Reset (Restablecer) se borra el curso de 

la medición.  

5.4.1 Monitor 

La opción Monitor permite mostrar los valores de las mediciones con activación externa (bien el sen-

sor o el software de control remoto). Al hacer clic en Monitor aparece un diálogo de selección: 

 

 
Figura 29. Seleccionar la aplicación que desea monitorizar en el Web Client 
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Haga clic en la fila con la aplicación que desea monitorizar. Se abre el siguiente cuadro de diálogo: 

 

 
Figura 30. Monitorización de mediciones en el Web Client 

 

Pulse Start (Iniciar) para activar la función de monitorización. Cuando el CoatMaster está funcio-

nando en el modo automático o las mediciones son activadas por el software de control remoto, el 

curso de la medición puede controlarse continuamente mediante esta pantalla. 
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5.4.2 Ajustes del CoatMaster Web Client 

 
Figura 31. Ajustes en el Web Client 

 

En este cuadro de diálogo se definen los ajustes para visualizar tendencias de medición con el Coat-

Master Web Client. 

Número de mediciones guardadas: Número de mediciones recientes guardadas en el equipo. 

Número de mediciones mostradas: El número de mediciones recientes que se muestran en la curva 

de medición. 

Leyenda del eje X: Es posible seleccionar la hora de medición o el índice de medición como leyenda 

para el eje X.  

Calcular el valor medio y la desviación estándar para los últimos X valores: El número de últimos 

valores medidos para los que se calculará el valor medio y la desviación estándar. 

 

Haga clic en Save (Guardar) para guardar los ajustes. 

  

5.5 Crear nuevas aplicaciones CoatMaster  

Esta función solo está disponible en el sistema operativo CoatMaster. 

 

Los procesos de revestimiento se especifican mediante un valor límite superior e inferior para el es-

pesor del revestimiento (ventana de tolerancia). Para la calibración mediante mediciones de referen-

cia, recomendamos usar al menos una muestra con un revestimiento en el límite inferior y otra en el 
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límite superior de la ventana de tolerancia. Con cada una de estas muestras de referencia, realice 2-4 

mediciones con el CoatMaster para poder medir posteriormente el espesor del revestimiento con un 

método de referencia en los mismos puntos de medición. 

Para obtener los mejores resultados, recomendamos usar los mismos materiales y piezas para la cali-

bración que se usarán después para la medición. No obstante, el CoatMaster admite ciertas desvia-

ciones entre la calibración y la medición, del siguiente modo: 

1. Calibración en sustrato de metal y medición en sustrato con combinaciones de aleación lige-

ramente diferentes (por ejemplo, distintos tipos de acero).  

2. Calibración en placas finas y medición en placas gruesas o viceversa (activar la casilla de veri-

ficación Enable variation of substrate properties [Activar variación de las propiedades del sus-

trato] en el software).  

3. Calibración en superficies planas y medición en superficies redondas. 

4. Es aceptable un cierto grado de variación de temperatura, en función del revestimiento y el 

material del sustrato. 

Los siguientes factores influyen en la medición del CoatMaster, de modo que deberían mantenerse 

las mismas condiciones durante la calibración y la medición: 

1. Rugosidad de la superficie: Si la medición se realiza en superficies rugosas, la calibración de-

bería realizarse en superficies rugosas también. 

2. Superficie del revestimiento: Si solo está revestida una superficie pequeña o discontigua, la 

calibración debe realizarse también en la superficie pequeña. 

3. Material del sustrato: En caso que el mismo revestimiento se mida en materiales de sustrato 

diferentes (por ejemplo, en metal o plástico o en aluminio y acero) deberá crearse una nueva 

aplicación CoatMaster para cada material de sustrato. 

Las muestras de referencia deben conservarse, si es posible, para verificar la estabilidad a largo plazo 

del CoatMaster. 

  

Para crear una nueva aplicación, obtenga las muestras de referencia y téngalas a mano para el pro-

ceso de calibración. Encienda el CoatMaster e inicie el CoatMaster Desktop. En la aplicación, en la 

parte izquierda, haga clic en el botón New application (Aplicación nueva) (ver la zona 2 de la Figure 

16 en la página 26). Si este botón está sombreado, el administrador ha bloqueado esta función para 

el usuario (ajuste de fábrica). Para desbloquear esta función, escriba la contraseña del administrador 

(consulte el capítulo 4.4.4). 

 

Siga el procedimiento de configuración de la aplicación que se indica a continuación. 

5.5.1 Configuración de la aplicación 

Después de hacer clic en el botón New Application (Aplicación nueva), se abre el diálogo de ajuste de 

la aplicación: 
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Figura 32. Configurar una aplicación en el software independiente 
 

En el campo Name (Nombre) escriba un nombre para la nueva aplicación.  

En Coating (Revestimiento) seleccione el material de revestimiento más apropiado en el menú des-

plegable. Si no hay un material de revestimiento apropiado disponible, seleccione Unknown (Desco-

nocido). 

En caso necesario, modifique los ajustes de Tolerancia para el revestimiento. Rellene los campos para 

el límite superior e inferior para definir la ventana de tolerancia. 

En Sustrato seleccione el material de sustrato más apropiado en el menú desplegable. 

En caso necesario, modifique los ajustes de Tolerancia para el sustrato. Rellene los campos para el 

límite superior e inferior para definir la ventana de tolerancia. 

En Calibration method (Método de calibración) seleccione el botón de radio Measurement (Medi-

ción), cuando la calibración se realiza mediante una medición, o Material, cuando la calibración se 

realice de acuerdo con la base de datos de materiales existentes del CoatMaster.  
 

AVISO 

Cuando se selecciona Material, la nueva aplicación estará dispnible sin necesidad de más pasos y 

puede finalizarse haciendo clic en Save (Guardar). La calibración se realiza de acuerdo con las propie-

dades del material almacenadas en la base de datos de materiales. Nuestra base de datos se amplía y 

actualiza continuamente. No obstante, las desviaciones en el material de revestimiento respecto de 

los materiales estándares almacenados en la base de datos pueden producir errores en los valores de 

medición. Para obtener resultados más precisos, utilice la calibración mediante mediciones de refe-

rencia. 
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Desviación: Deje la casilla de verificación Thickness Offset (Desviación del espesor) inactiva en este 

momento. Necesita más información acerca de la correlación entre las mediciones del CoatMaster y 

las mediciones de referencia para decidir sobre esta opción. Esta información está disponible des-

pués de haber realizado el procedimiento de calibración (ver el capítulo ). 

 

Haga clic en Next > (Siguiente). Aparece el siguiente cuadro de diálogo: 

 

5.5.2 Mediciones de referencia 

 

Figura 33. Añadir mediciones de calibración en el software independiente 

 

Para realizar una nueva medición de referencia, coloque el objeto que desea medir delante de la ven-

tana de medición del CoatMaster y haga clic en Add (Añadir) para realizar la medición del CoatMas-

ter. 

 

Añada al menos una medición de referencia para todas las muestras de calibración. Para cada medi-
ción de referencia del CoatMaster, añada el valor de espesor de referencia haciendo clic en el campo 
del valor de referencia. El valor del espesor de referencia se determina a menudo mediante medido-
res de mano del espesor del revestimiento o mediante análisis microscópico de secciones transversa-
les. 
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Consulte el capítulo 5.6 en la página 55 para crear aplicaciones sobre revestimientos antes del cu-
rado. 

Si no se han especificado todos los valores de espesor de referencia para todas las mediciones del 
CoatMaster, no será posible proceder con la calibración. No obstante, la aplicación puede guardarse 
utilizando el botón Save (Guardar). Una aplicación guardada puede editarse y es posible introducir 
los valores de espesor de referencia en un momento posterior. 

Si todos los valores de espesor de referencia están disponibles, se activa el botón Next > (Siguiente). 
Al pulsar el botón Next > (Siguiente), se ejecuta el algoritmo de calibración. Los resultados de la cali-
bración se muestran en el informe de calibración (ver el capítulo Informe de calibración5.5.7). 

Es posible configurar más parámetros para cada aplicación. Estos parámetros controlan la visualiza-
ción de los valores de medición (capítulo 5.5.3), la energía lumínica y el tiempo de medición (capítulo 
5.5.4) y la evaluación de la medición (capítulos 5.5.5 y 5.5.6).  

5.5.3 Visualización 

Esta pestaña contiene más ajustes sobre la visualización de los valores de medición. 

 

 
Figura 34. Seleccionar los límites para las mediciones en el software independiente  

 

Posiciones decimales para el espesor del revestimiento: Define el número de posiciones decimales 

que se mostrarán. 
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La ventana de tendencias puede dividirse en tres zonas: tolerancia (gris), advertencia (naranja claro) 

y error (naranja oscuro). Si un número especificado de mediciones consecutivas se encuentra en el 

rango de advertencia, se muestra el símbolo del rango de advertencia  en la ventana de medi-

ción. Si un número especificado de mediciones consecutivas se encuentra en el rango de error, se 

muestra el símbolo del rango de error  en la ventana de medición. En caso de error, es posible 

configurar un mensaje de error que debe ser confirmado por el usuario antes de poder continuar con 

las mediciones. 

 
Especificación de los rangos de tolerancia, advertencia y error  

Tolerancia: Especifique los límites superiores e inferiores para el rango de tolerancia para el espesor 

del revestimiento en la ventana de tendencia (zona gris). N.º de mediciones hasta advertencia: Espe-

cifica el número de mediciones consecutivas en el rango de advertencia antes de que se muestre el 

símbolo del rango de advertencia. 

Error:  Especifica los límies inferior y superior entre los rangos de advertencia y error para el espesor 

del revestimiento en la ventana de tendencia. N.º de mediciones hasta error: Especifica el número de 

mediciones consecutivas en el rango de advertencia antes de que se muestre el símbolo del rango de 

error. 

 

Rango: Especifica los límites de visualización inferior y superior para la ventana de tendencia. 

 

Consulte el ejemplo siguiente que muestra los rangos de tolerancia, advertencia y error en la ventana 

de tendencia, correspondiente a los ajustes en la pestaña Display (Visualización) de los ajustes de la 

aplicación: 

 

 
Figura 35. Todas las mediciones en un bloque se representan en la ventana de tendencias 
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AVISO 

Los ajustes para el rango de tolerancia, las unidades y las posiciones decimales solo afectan al gráfico 

de tendencia y a la visualización de los valores de medición y no tiene ninguna influencia sobre el 

cálculo de los valores de medición. 

 

Haga clic en Save (Guardar) para guardar la nueva aplicación, añadirla a la lista de aplicaciones y ce-
rrar el diálogo. 
Haga clic en Cancel (Cancelar) para cerrar el diálogo sin guardar. 

5.5.4 Instrumento 

 

 

Figura 36. Ajustar la duración de la medición, la energía lumínica y el umbral de SNR en el software independiente 

 

 

Tiempo de medición (ms): define la duración de la medición de temperatura de la superficie diná-

mica. El campo contiene un valor por defecto determinado por la elección del material de revesti-

miento y el rango de espesor.  

 

Energía lumínica (J): Define el nivel de energía de la luz flash. Esta opción solo está disponible si no 

hay mediciones de referencia almacenadas en la aplicación. Aumente este valor para aumentar la 

SNR para obtener una mejor repetibilidad o para aumentar la distancia entre la superficie del revesti-

miento y el CoatMaster. Una SNR demasiado baja puede motivar una calibración insatisfactoria. 
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Umbral de SNR: Se descartarán las mediciones con un valor de SNR inferior a este. Defina el umbral 

de SNR a un valor inferior al valor de SNR que se muestra en el informe de calibración. Si el valor del 

umbral de SNR es demasiado alto, se descartarán mediciones válidas. Si el valor del umbral de SNR es 

demasiado bajo, podrían no descartarse mediciones no válidas. 

 

5.5.5 Evaluación 

 
Figura 37. Ajustes para la evaluación en el software independiente 

 

 

Permitir variación de las propiedades del sustrato: Debe activarse esta casilla de verificación si la 

calibración y la medición se realizan en sustratos con espesores diferentes (chapas metálicas diferen-

tes).  

 

AVISO 

Para obtener resultados óptimos, recomendamos realizar la calibración y la medición en condiciones 

tan similares como sea posible. 

 

Permitir variación de las propiedades de la superficie: Active esta casilla de verificación cuando la 

rugosidad superficial pueda variar, para revestimientos semitransparentes o cuando el revestimiento 

sea tan fino que el sustrato resulte visible a través del revestimiento. Este ajuste puede aumentar la 

calidad de medición en una calibración no satisfactoria. 
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Los campos Advertencia y Error muestran el valor de umbral correspondiente que señala el límite 

para un mensaje de advertencia o error (marcando una medición posterior como no satisfactoria), 

cuando el valor de medicion se desvíe demasiado de la aplicación usada. En caso de advertencia, se 

muestra el icono de advertencia en la ventana principal junto al valor de medición. En caso de error, 

se muestra el icono de error. 

Los ajustes predefinidos son una sugerencia de acuerdo con los datos de medición adquiridos con la 

aplicación.  

 

5.5.6 Límites 

Los ajustes en este diálogo se predefinen de acuerdo con el ajuste de material para la aplicación. 

Para modificar los ajustes en este diálogo, debe activarse la casilla de verificación definida por el 

usuario. 

 

AVISO 

Estos ajustes tienen gran influencia en la calidad de la aplicación y, por lo tanto, en la calidad de los 

resultados de medición. Están reservados para expertos con conocimientos técnicos. 

 
Figura 38. Límites superior e inferior de los parámetros para la evaluación. Nota: No debe modificarse sin conocimientos 
expertos. 

 

Tiempo de capa constante: Tiempo necesario para que el calor penetre en la capa 

Óptica constante: Indica hasta qué profundidad penetran la luz o el calor, respectivamente, en el re-

vestimiento, es decir, indica las propiedades de absorción del revestimiento 
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Contraste de efusividad: Indica el contraste en las propiedades térmicas del revestimiento y el sus-

trato  

Resistencia de contacto: Indica si el calor tiene que superar una barrera al atravesar la transición en-

tre dos revestimientos o entre el revestimiento y el sustrato 

Ganancia: Indica a qué distancia se encuentra el CoatMaster de la muestra, es decir, en qué medida 

se absorbe el calor y se emite de nuevo. 

5.5.7 Informe de calibración 

Una vez finalizado el proceso de calibración, se muestra el resultado de la calibración en el informe 
de calibración. 

 

Figura 39. Resultados de la calibración en el software independiente 

 

El algoritmo de calibración determina si la correlación entre el CoatMaster y las mediciones de refe-
rencia es buena y si las mediciones del CoatMaster son fiables. El algoritmo utiliza las siguientes me-
diciones: 

Desviación media: 

> 25 %: La desviación entre el CoatMaster y las mediciones de referencia es excesiva.  

entre 10 y 25 %: la correspondencia no es óptima. 

< 10 %: la correspondencia es aceptable. 
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Formas de reducir la desviación media: 

 Posiblemente haya una medición de referencia atípica o incorrecta. Sucede cuando los pun-

tos en el gráfico de correlación se encuentran generalmente en una línea recta, excepto un 

punto. En este caso, elimine el punto atípico en la lista de mediciones de referencia pulsando 

el botón < Back (Atrás). 

 Es posible que las mediciones de CoatMaster se hayan visto alteradas. Repita todas las medi-

ciones de referencia de CoatMaster. 

 Si los puntos del gráfico de correlación se encuentran en línea recta pero no en la línea de 

calibración, activar la opción Offset (Desviación) mejora la desviación media (ver el capítulo ). 

 

 

Índice de calidad: 

> 94 %: Este índice de calidad es bueno. 

Entre 90 y 94 %: Este índice de calidad es aceptable, pero podría mejorarse. Un índice de calidad su-

perior permitiría obtener una medición más precisa.   

< 90 %: Este índice de calidad no es bueno.  

 

Formas de mejorar el índice de calidad: 

 Es posible que los materiales seleccionados para el revestimiento y el sustrato no coincidan 

bien con los materiales reales.  En este caso, seleccione la opción unknown (desconocido) 

para el material del sustrato y el revestimiento. 

 Repita las mediciones de blanco, como se describe en el capítulo 7.6. 

 

SNR:  

< 20: Un valor de SNR inferior a 20 es muy bajo y puede dar lugar a mediciones poco fiables. 

 

Formas de mejorar la SNR: 

 Coloque la pieza más cerca de la abertura de medición del CoatMaster. No coloque la super-

ficie de la pieza a menos de 5 cm de la abertura de medición del CoatMaster. Tenga en 

cuenta que al cambiar la distancia entre la pieza y la abertura de medición también se cam-

bia el tamaño del punto de medición (ver el capítulo ).  

 Aumente la energía lumínica en la aplicación. Deberá borrar todas las mediciones de referen-

cia anteriores para poder cambiar el ajuste de energía lumínica (ver el capítulo ). 

 Si estas dos acciones no ayudan, utilice un amplificador de reflejo óptico. 

 

5.5.8 Desviación de la aplicación 

El trazado de datos de CoatMaster y la medición de referencia podrían mostrar en ocasiones una 

desviación sistemática entre los valores de referencia y de CoatMaster. Esto puede detectarse por el 

hecho de que para recubrimientos finos, todos los puntos de calibración se encuentran encima de la 

línea de calibración, mientras que para recubrimientos gruesos todos los puntos de calibración están 

debajo (o viceversa). El ejemplo siguiente ilustra esta situación: 
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Figura 40. Resultados de la calibración en el software independiente 

 

Aunque la desviación media está por debajo del límite del 25 % que produce una calibración no satis-

factoria, es evidente una desviación sistemática del valor de espesor del recubrimiento de referencia 

y de CoatMaster. En este caso, es apropiado permitir la desviación para esta aplicación. Con este ob-

jetivo, seleccione Back (Atrás) dos veces para regresar a la primera página, active la opción Thickness 

offset (Desviación del espesor) y seleccione Next (Siguiente) dos veces. 

Después de habilitar la desviación, el trazado de datos muestra ahora una menor desviación media: 
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Figura 41. Resultados de la calibración en el software independiente 

 

Desviación: Muestra la desviación de la calibración (en este caso 11 µm).  

La desviación permite equilibrar las desviaciones sistemáticas entre la referencia y el CoatMaster. Es-

tas desviaciones pueden producirse especialmente en sustancias/recubrimientos rugosos o porosos. 

Para determinar correctamente la desviación, se necesitan al menos de cuatro a ocho mediciones de 

referencia. 
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5.6 Aplicaciones CoatMaster para recubrimientos antes de la curación 

El CoatMaster puede utilizarse para medir el espesor del recubrimiento antes de su curación sin to-

car (y por lo tanto destruir) el recubrimiento. Esto permite usar el CoatMaster para control de proce-

sos y para medir estadísticas del proceso.  Para este objetivo, el CoatMaster puede configurarse para 

predecir el espesor del recubrimiento curado a partir de las mediciones antes de la curación. Estos 

pasos requieren crear una aplicación según se describe en el capítulo 5.6.3. 

 

Deben tomarswe consideraciones especiales para medir antes de la curación, en función del tipo de 

recubrimiento (en polvo o húmedo), como se describe en los capítulos 5.6.1 y 5.6.2. 

5.6.1 Medir recubrimientos en polvo antes de la curación 

Los recubrimientos en polvo no tienen un grosor uniforme; por el contrario, la superficie presenta 

ondulaciones y el espesor cambia en una distancia de pocos milímetros. Estas ondulaciones están in-

fluidas por distintos parámetros, como el pretratamiento, el tipo y las ondulaciones del sustrato, el 

tipo de pintura (como la distribución del tamaño del grano y la composición química). Las ondulacio-

nes también son visibles después del curado y dependen de las condiciones del curado (distribución 

de temperatura, tiempo de curado). ¡Error! No se encuentra el origen de la referencia. muestra un 

xtracto de 2 x 2 mm de una superficie con recubrimiento en polvo con diferencias de espesor de 15 

µm. 

 
Figura 42: Ondulaciones de recubrimiento en polvo después de la curación 

 

El principio de medición del CoatMaster puede compensar estas ondulaciones mediante una prome-

diación óptica, lo que permite determinar el espesor del recubrimiento de manera fiable. 

 

5.6.2 Medir recubrimientos húmedos antes de la curación/secado 

El espesor del recubrimiento húmedo normalmente se mide para determinar el espesor del recubri-

miento después de la curación. Esto solo produce resultados repetibles si la relación entre el solvente 
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y los sólidos se mantiene constante. Sin embargo, en un recubrimiento húmedo el solvente se evapora, 

por lo que la relación cambia con el tiempo. Por lo tanto, las mediciones de referencia del CoatMaster 

deberían realizarse en el mismo estado del recubrimiento que cuando el CoatMaster vaya a utilizarse 

para realizar mediciones.  

 

5.6.3 Procedimiento para crear aplicaciones CoatMaster para medir el espesor del recubrimiento 

antes de la curación 

1. Produce piezas de referencia que se utilizan para la aplicación CoatMaster. Estas partes deben 

cubrir el rango que va a medirse con el CoatMaster. Por ejemplo, este rango puede ser el rango 

de tolerancia del proceso de recubrimiento. Sugerimos crear dos piezas al espesor mínimo y 

dos piezas al espesor máximo del rango de medición. 

2. Cree una nueva aplicación en el CoatMaster como se describe en el capítulo 5.5 Crear nuevas 

aplicaciones CoatMaster . Elija un nombre para esta aplicación que indique que esta aplicación 

va a utilizarse para medición en el proceso (por ejemplo, “estado húmedo”). En cada pieza de 

referencia, si es posible, tome dos mediciones de referencia con el CoatMaster en distintas 

posiciones. Pulse Save (Guardar) después de tomar la medición de referencia sin introducir los 

valores de referencia. Asegúrese de que sea posible volver a encontrar las posiciones de las 

mediciones de referencia, por ejemplo marcando las posiciones de medición sin destruir el 

recubrimiento. Obtendrá un total de ocho mediciones de referencia para las aplicaciones Coat-

Master. En función de la precisión del método para medir el valor de referencia, el número de 

mediciones necesarias podría variar. 

3. Finalice la curación del recubrimiento en las piezas de referencia. 

4. Mida el espesor del recubrimiento en las piezas de referencia en las posiciones marcadas con 

un método de referencia (por ejemplo, análisis microscópico de secciones transversales). In-

troduzca el espesor del recubrimiento en las aplicaciones CoatMaster “húmedo” . 

5. Si es posible y necesario, cree otra nueva aplicación en el CoatMaster, añadiendo mediciones 

de referencia sobre las piezas de referencia curadas en las mismas posiciones. Si las piezas se 

han cortado para su análisis microscópico, realice las mediciones de referencia cerca de la po-

sición original. Elija un nombre para esta aplicación que indique que esta aplicación solo va a 

utilizarse con piezas curadas (por ejemplo, “estado curado”). Esta aplicación solo es necesaria 

para la verificación periódica del correcto funcionamiento del CoatMaster en las piezas de re-

ferencia. 

6. Repita las mediciones en las piezas de referencia con la aplicación CoatMaster “curado” en las 

posiciones marcadas. Anote los valores del espesor del recubrimiento del CoatMaster para 

cada posición. Estos valores ceben ser cercanos, pero podrían no ser exactamente iguales que 

los valores del método de referencia. El CoatMaster debería producir siempre estos mismos 

valores al repetir las mediciones en las piezas de referencia. 
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5.7 Copia de seguridad y transferencia de aplicaciones CoatMaster 

Los datos de la aplicación se almacenan en el ordenador integrado de CoatMaster. Si este ordenador 

se bloquea o sufre daños, se perderá el trabajo para crear las aplicaciones. Por lo tanto, se reco-

mienda descargar las aplicaciones exportando estos datos del CoatMaster en un almacenamiento ex-

terno. Además, las aplicaciones también pueden transferirse entre sistemas CoatMaster distintos.  

5.7.1 Exportar aplicaciones 

Para exportar una aplicación, seleccione File > Export (Archivo > Exportar). Aparece el diálogo si-

guiente: 

 

 
Figura 43. Ventana Exportar en el software independiente 

 

Haga doble clic en Application (Aplicación), seleccione el submenú Export Application (Exportar apli-

cación) y haga clic en Next > (Siguiente). Aparece el diálogo siguiente: 
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Figura 44. Ventana para exportar una aplicación en el software independiente 

 

En la lista de aplicaciones, seleccione las que desea exportar y haga clic en el botón ... para definir la 

ruta y el nombre del archivo de exportación. Haga clic en Save (Guardar) y después en Finish (Finali-

zar) en el diálogo de exportación. El archivo exportado se guarda como un archivo *.cmz con la ruta y 

el nombre definidos. 
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5.7.2 Importar aplicaciones 

Para importar aplicaciones exportadas previamente, seleccione File > Import (Archivo > Importar). 

Aparece el diálogo siguiente: 

 

 
Figura 45. Ventana para importar una aplicación en el software independiente 

 

Haga doble clic en Application (Aplicación), seleccione el submenú Import Application (Importar apli-

cación) y haga clic en Next > (Siguiente). Aparece el diálogo siguiente: 
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Figura 46. Selecionar la aplicación que desea importar en el software independiente 

 

Hag clic en el botón .... En el diálogo que aparece, seleccione el archivo *.cmz que desea importar y 

haga clic en Open (Abrir). La ruta correspondiente se muestra en la ventana de importación. A conti-

nuación, haga clic en Finish (Finalizar). El archivo de la aplicación se importa y se añade a la lista de 

aplicaciones. 
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5.8 Importar un archivo de material 

Para importar los ajustes para un material de recubrimiento o sustrato, seleccione File > Import (Ar-

chivo > Importar). Estos datos solo pueden obtenerse de Winterthur Instruments bajo pedido para 

nuevos materiales de recubrimiento o sustrato. Aparece el diálogo siguiente: 

 

 
Figura 47. Importar archivos de materiales en el software independiente 
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Haga doble clic en Material, seleccione el submenú Import Material (Importar material) y haga clic en 

Next > (Siguiente). Aparece el diálogo siguiente: 

 
Figura 48. Seleccionar el archivo que desea importar en el software independiente 

 

Haga clic en el botón .... En el diálogo que aparece, seleccione el archivo *.xml que desea importar y 

haga clic en Open (Abrir). A continuación, haga clic en Finish (Finalizar). Se importan los ajustes para 

el material seleccionado y ya están disponibles para desarrollar aplicaciones. 
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5.9 Exportar datos de medición 

Para exportar los datos de medición, seleccione File > Export (Archivo > Exportar) o haga clic en el 

icono  en la zona Application (Aplicación) de la ventana principal. Aparece el diálogo siguiente: 

 

 
Figura 49. Exportar los datos de medición en el software independiente 

 

Haga doble clic en Data (Datos), seleccione el submenú Export data (Exportar datos) y haga clic en 

Next > (Siguiente). Aparece el diálogo siguiente: 
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Figura 50. Seleccionar las mediciones que desea exportar en el software independiente 
 

 

Con los ajustes de filtro para fecha y hora, seleccione el periodo para el cual desea exportar los datos 

y haga clic en el botón de actualizar con las dos flechas. A continuación, haga clic en Export... (Expor-

tar). Se abre un diálogo Save as (Guardar como) donde pueden definirse la ruta y el nombre para el 

archivo de datos. Ahora haga clic en Save (Guardar). El archivo de exportación se guarda como un 

archivo XML, CSV o QDAS con la ruta y el nombre definidos. 
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6 Control remoto 

En este capítulo se describe la utilización del CoatMaster usando cualquier dispositivo que se conecte 

al CoatMaster a través de la Ethernet. Puede ser por ejemplo un PLC (como el Siemens S7) o un orde-

nador donde se ejecute software de un tercero. El software CoatMaster Operating System utiliza un 

protocolo remoto para controlar el CoatMaster. 

 

El CoatMaster se maneja mediante comandos que se envían desde el dispositivo al CoatMaster. El 

resultado del comando se envía desde el CoatMaster al dispositivo. El CoatMaster funciona como un 

servidor para la operación de control remoto. El equipo funciona como un cliente.  

 

Es posible utilizar una interfaz basada en TCP/IP o HTTP para el control remoto del CoatMaster.  

 

Haga lo siguiente para utilizar la interfaz TCP/IP: 

 

Los comandos y resultados para la interfaz TCP/IP se enumeran en el capítulo 6.1. 

 

Haga lo siguiente para utilizar la interfaz HTTP: 

 

Los comandos y resultados para la interfaz TCP/IP se enumeran en el capítulo 0. 

 

6.1 TCP/IP  

Los comandos y los resultados se transfieren como líneas de texto ASCII. Después de procesar un co-

mando, el servidor CoatMaster desconecta la conexión TCP/IP para permitir el acceso a otros clien-

tes. Debe volver a establecerse la conexión para el siguiente comando. 

 

Puede encontrar ejemplos de código usando el protocolo TCP/IP en el enlace siguiente: 

http://winterthurinstruments.ch/en/integratoren.html 

 

Nota importante para los usuarios de un Siemens SIMATIC S7 PLC: 

El Siemens S7 PLC está disponible en dos tipos de producto diferentes, que reaccionan de forma dife-

rente con una conexión Ethernet: el tipo PN/DP y el tipo DP.  

 

Tipo PN/DP: Este tipo tiene Ethernet integrado en la CPU. La conexión Ethernet se abre y cierra auto-

máticamente y no requiere introducir comandos especiales en el software.  

 

Tipo DP: Este tipo no tiene Ethernet integrado en la CPU. Para este tipo, debe abrirse la conexión Et-

hernet antes de cada comando y cerrarse después de cada comando por el software.  

 

http://winterthurinstruments.ch/en/integratoren.html
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6.1.1 Formato general de comandos y resultados 

Una cadena de línea de comandos tiene el formato siguiente:  

COMMAND?ARG1=VAL1&ARG2=VAL2&...CR/LF 

 

Los elementos en una línea de comandos tienen el significado siguiente: 

“COMMAND”: Nombre del comando 

“?”: Separa un comando de los argumentos 

“ARGx”: Nombre de un argumento del comando 

“VALx”: Valor para el argumento del comando 

“=”: Signo separador entre el argumento del comando y el valor  

“&”: Signo separador entre argumentos del comando 

<...>: Marcador de posición para valores dinámicos 

-----: Línea separadora 

“CR/LF”: completa el comando (salto de línea (Hex 0D 0A, secuencia de escape \r\n)) 

 

El CoatMaster responde a los comandos con resultados en un formato similar: 

 

RESULT?ARG1=VAL1&ARG2=VAL2&...CR/LF 

 

“RESULT”: Nombre del resultado 

“?”: Separa un comando de los argumentos 

“ARGx”: Nombre de un argumento del comando 

“VALx”: Valor para el argumento del comando 

“=”: Signo separador entre el argumento del comando y el valor  

“&”: Signo separador entre argumentos del comando 

<...>: Marcador de posición para valores dinámicos 

-----: Línea separadora 

“CR/LF”: completa el comando (salto de línea (Hex 0D 0A, secuencia de escape \r\n)) 

 

El STATUS (estado) del argumento se incluye con cada resultado del comando y adopta los valores 

siguientes: 

 OK: El comando se ha ejecutado correctamente 

 ERROR: El comando no se ha ejecutado correctamente y se ha cancelado. 

 PENDING: El comando sigue pendiente.  

 WARNING: Advertencia, por ejemplo cuando los valores de medición no son fiables 

 MESSAGE=<VAL>: Descripción del problema en caso de mensaje de error o advertencia 
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6.1.2 Comando MEASURE 

Utilice el comando MEASURE para activar una medición de CoatMaster. Debe seleccionar una aplica-

ción de CoatMaster para la medición, que se especifica mediante una ID y es el único argumento 

para el comando MEASURE. 

 

Comando Argumentos Descripción 

MEASURE CONFIGID  Ejecuta una medición usando la aplicación con la ID espe-

cificada por CONFIGID. Las ID de todas las aplicaciones al-

macenadas en el CoatMaster pueden recuperarse me-

diante el comando GETCONFIGURATIONS. 

 

Ejemplo de uso 

Comando para activar una medición con la ID de aplicación n.º 1: 

MEASURE?CONFIGID=1<CR/LF> 

 

Resultado Argumentos Descripción 

RES_MEASURE STATUS Como se describe en el capítulo 6.1.1. 

 MEASURE_ID Cada resultado de medición recibe un número de ID ex-

clusivo (entero). 

 THICKNESS Resultado de espesor del recubrimiento (número de coma 

flotante) 

 TIMESTAMP Marca de tiempo de la medición (entero). El valor de este 

argumento representa "milisegundos desde el 1 de enero 

de 1970 a las 00:00:00 GMT". Consulte http://www.epo-

chconverter.com/ para obtener una descripción sobre 

cómo convertir este número al formato de hora deseado. 

 

Ejemplo de resultado: 

RES_MEASURE?STATUS=OK&MEASURE_ID=3&THICK-

NESS=12.0&TIMESTAMP=1362061773072<CR/LF> 

 

En este ejemplo, el resultado de la medición es 12,0 μm y el valor 1362061773072 representa la es-

pecificación de hora 28. Febrero de 2013, a las 14.29 h. GMT   

 

Mensajes de error y advertencia 

Como resultado de un comando MEASURE, pueden devolverse mensajes de advertencia y error. En 

este caso, el resultado tiene el formato: 

 

RES_MEASURE?STATUS=ERROR&MESSAGE={mensaje de error}<CR/LF> 

RES_MEASURE?STATUS=WARNING&MESSAGE={mensaje de advertencia}<CR/LF> 

 

La parte de texto entre corchetes {…} contiene un código para el error o la advertencia: 

http://www.epochconverter.com/
http://www.epochconverter.com/
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Argumento Valores Descripción 

MESSAGE 1 Descripción del error 1 

 2 Descripción del error 2 

 

6.1.3 Comando GETCONFIGURATIONS 

Utilice el comando GETCONFIGURATIONS para recuperar una lista de todas las aplicaciones almace-

nadas en el CoatMaster. Este comando no tiene argumentos. 

 

Comando Argumentos Descripción 

GETCONFIGU-

RATIONS 

  

 

Ejemplo de uso:  

GETCONFIGURATIONS<CR/LF> 

 

Resultado Argumentos Descripción 

RES_GETCONFIGURA-

TIONS 

NAME Nombre que el usuario ha dado a la aplicación 

 ID ID para esta aplicación (entero) 

 … Por cada aplicación almacenada en el CoatMas-

ter, se devuelve el NAME y la ID. 

 

Ejemplo de resultado: 

RES_GETCONFIGURATIONS?STATUS=OK&ID=2&NAME=paint1&ID=4&NAME=paint2<CR/LF> 

 

En este ejemplo hay dos aplicaciones almacenadas en el CoatMaster. La aplicación llamada “paint1” 

tiene la ID 2 y la aplicación llamada “paint2” tiene la ID 4. Las ID no tienen por qué ser números con-

secutivos. 

6.1.4 Comando GETCONFIGIDS 

Utilice el comando GETCONFIGIDS para recuperar una lista de las ID de todas las aplicaciones almace-

nadas en el CoatMaster. Este comando no tiene argumentos. 

 

Comando Argumentos Descripción 

GETCONFIGIDS   

 

Ejemplo de uso  

GETCONFIGIDS<CR/LF> 

 

Resultado Argumentos Descripción 
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RES_GETCONFIGIDS STATUS Como se describe en el capítulo 6.1.1. 

 ID ID de la primera aplicación (entero) 

 … Por cada aplicación almacenada en el CoatMaster, 

se devuelve la ID. 

 

Ejemplo de resultado: 

RES_GETCONFIGIDS?STATUS=OK&ID=2&ID=3&ID=5<CR/LF> 

 

En este ejemplo hay tres aplicaciones almacenadas en el CoatMaster. Tienen las ID 2, 3 y 5. Las ID no 

tienen por qué ser números consecutivos. 

 

6.1.5 Comando GETTHICKNESSBOUNDS 

Utilice el comando GETTHICKNESSBOUNDS para recuperar una lista de los límites de advertencia y 

error del espesor del recubrimiento especificados en una aplicación. Ver el capítulo 5.5.3 en la página 

46 para más información sobre los límites de advertencia y error del espesor del recubrimiento. 

 

Comando Argumentos Descripción 

GETTHICKNESS-

BOUNDS 

CONFIGID Especifica la ID de la aplicación para la cual desea obtener 

información sobre los límites de espesor del recubri-

miento. 

 

Ejemplo de uso:  

GETTHICKNESSBOUNDS?CONFIGID=1<CR/LF> 

 

Resultado Argumentos Descripción 

RES_GETTHICKNESS-

BOUNDS 

STATUS Como se describe en el capítulo 6.1.1. 

 HAS_WARNING Variable booleana (puede ser TRUE o FALSE) 

que muestra si se ha definido un rango de ad-

vertencia para la aplicación (ver el capítulo 

5.5.3 en la página 46). 

 WARNING_LO-

WER 

Límite inferior de espesor del recubrimiento en 

micrómetros para el rango de advertencia (en-

tero). Definido solo si el rango de advertencia 

está activo. 

 WARNING_UPPER Límite superior de espesor del recubrimiento 

en micrómetros para el rango de advertencia 

(entero). Definido solo si el rango de adverten-

cia está activo. 

 HAS_ERROR Variable booleana (puede ser TRUE o FALSE) 

que muestra si se ha definido un rango de 
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error para la aplicación (ver el capítulo 5.5.3 en 

la página 46). 

 ERROR_LOWER Límite inferior de espesor del recubrimiento en 

micrómetros para el rango de error (entero). 

Definido solo si el rango de error está activo. 

 ERROR_UPPER Límite superior de espesor del recubrimiento 

en micrómetros para el rango de error (en-

tero). Definido solo si el rango de error está ac-

tivo. 

 

Ejemplo de resultado: 

RES_GETTHICKNESSBOUNDS?STATUS=OK&HAS_WARNING=true&WARNING_LOWER=50&WARN-

ING_UPPER=60&HAS_ERROR=false&ERROR_LOWER=10&ERROR_UPPER=150<CR/LF> 

 

En este ejemplo, el rango de advertencia está activo mientras que el rango de error no está activo 

para la aplicación. El límite inferior para el rango de advertencia es 50 μm y el límite superior para el 

rango de advertencia es 60 μm. Los valores para los límites inferior y superior para el rango de error 

son irrelevantes. 

 

6.1.6 Comando STARTAUTOMATION (modo de automatización) 

Este comando va dirigido a ser utilizado en combinación con el modo de automatización del Coat-

Master Operating System. Consulte el capítulo ¡Error! No se encuentra el origen de la referencia. en 

la página ¡Error! Marcador no definido. para obtener más información sobre el modo de automatiza-

ción. 

6.1.7 Comando STOPAUTOMATION (modo de automatización) 

Este comando va dirigido a ser utilizado en combinación con el modo de automatización del Coat-

Master Operating System. Consulte el capítulo ¡Error! No se encuentra el origen de la referencia. en 

la página ¡Error! Marcador no definido. para obtener más información sobre el modo de automatiza-

ción. 

6.1.8 Comando TRIGGERAUTOMATIONSENSOR (modo de automatización) 

Este comando va dirigido a ser utilizado en combinación con el modo de automatización del Coat-

Master Operating System. Consulte el capítulo ¡Error! No se encuentra el origen de la referencia. en 

la página ¡Error! Marcador no definido. para obtener más información sobre el modo de automatiza-

ción. 
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6.1.9 Comando GETAUTOMATIONSTATE (modo de automatización) 

Este comando va dirigido a ser utilizado en combinación con el modo de automatización del Coat-

Master Operating System. Consulte el capítulo ¡Error! No se encuentra el origen de la referencia. en 

la página ¡Error! Marcador no definido. para obtener más información sobre el modo de automatiza-

ción. 

 

6.1.10 Comando CREATESAMPLE (modo de automatización) 

Este comando va dirigido a ser utilizado en combinación con el modo de automatización del Coat-

Master Operating System. Consulte el capítulo ¡Error! No se encuentra el origen de la referencia. en 

la página ¡Error! Marcador no definido. para obtener más información sobre el modo de automatiza-

ción y el capítulo 5.3.1.1¡Error! No se encuentra el origen de la referencia. en la página 29 para ob-

tener más información sobre los bloques de muestras. 

 

Comando Argumentos Descripción 

CREATESAMPLE CONFIGID Especifica la ID de la aplicación para la cual desea generar 

un nuevo bloque de muestras.  

 

Ejemplo de uso:  

CREATESAMPLE?CONFIGID=12<CR/LF> 

 

Creará un nuevo bloque de muestras en la aplicación con la ID n.º 1. 

 

Resultado Argumentos Descripción 

RES_CREATE-

SAMPLE 

SAMPLE_ID La ID del bloque de muestras recién creado (entero). 

 

Ejemplo de resultado: 

RES_CREATESAMPLE?SAMPLE_ID=211<CR/LF> 

 

El nuevo bloque tiene la ID número 211. El CoatMaster Operating System define automáticamente el 

bloque como activo. 

 

6.1.11 Comando GETNUMBEROFMEASUREMENTS 

Utilice el comando GETNUMBEROFMEASUREMENTS para … 

 

Comando Argumentos Descripción 

GETNUMBEROF-

MEASURE-

MENTS 
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Ejemplo de uso:  

  

 

Resultado Argumentos Descripción 

RES_GETNUM-

BEROFMEASU-

REMENTS 

  

 

Ejemplo de resultado: 

 

6.1.12 Comando GETSERVICESTATUS 

Utilice el comando GETSERVICESTATUS para … 

 

Comando Argumentos Descripción 

GETSERVICESTA-

TUS 

  

 

Ejemplo de uso:  

  

 

Resultado Argumentos Descripción 

RES_ GETSERVICESTATUS   

 

Ejemplo de resultado: 

 

6.1.13 Comando GETAMBIENTSENSORDATA (solo CoatMaster Inline) 

Utilice el comando GETAMBIENTSENSORDATA para consultar el estado de los sensores ambientales. 

Consulte también el capítulo  en la página . 

 

Comando Argumentos Descripción 

GETAMBIEN-

TSENSORDATA 

  

 

Ejemplo de uso:  

GETAMBIENTSENSORDATA <CR/LF> 

 

El formato del resultado depende del STATUS. 

 

STATUS=OK: 
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Resultado Argumentos Descripción 

RES_GETAM-

BIENTSENSOR-

DATA 

STATUS OK 

 SENSOR-STATUS NORMAL 

 TEMPERATURE La temperatura del líquido de refrigeración en °C (número 

de coma flotante). 

 WATER-FLOW El caudal del líquido de refrigeración en litros por minuto 

(número de coma flotante). 

 WATER-LEVEL El nivel del líquido de refrigeración en el depósito en % 

(número de coma flotante). 

 

STATUS=ERROR: Es el caso si alguno de los valores de los sensores está por debajo del umbral prees-

tablecido. El sensor que está por debajo del nivel de umbral se indica después del campo SENSOR-

STATUS-… : 

  

Resultado Argumentos Descripción 

RES_GETAMBIENTSENSOR-

DATA 

STATUS ERROR 

 SENSOR-STA-

TUS-TEMPERA-

TURE 

CRITICAL (solo presente si este sensor está en un 

nivel crítico) 

 SENSOR-STA-

TUS-WATER-

FLOW 

CRITICAL (solo presente si este sensor está en un 

nivel crítico) 

 SENSOR-STA-

TUS-WATER-

LEVEL 

CRITICAL (solo presente si este sensor está en un 

nivel crítico) 

 TEMPERATURE La temperatura del líquido de refrigeración en °C 

(número de coma flotante). 

 WATER-FLOW El caudal del líquido de refrigeración en litros por 

minuto (número de coma flotante). 

 WATER-LEVEL El nivel del líquido de refrigeración en el depósito 

en % (número de coma flotante). 

 

 

Ejemplo de resultado con STATUS=OK: 

RES_GETAMBIENTSENSORDATA?STATUS=OK&SENSOR-STATUS=NORMAL&TEMPERA-

TURE=3.0&WATER-FLOW=7.0&WATER-LEVEL=600.0<CR/LF> 

 

Ejemplo de resultado con STATUS=ERROR: 
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RES_GETAMBIENTSENSORDATA?STATUS=ERROR&SENSOR-STATUS-WATER-FLOW=CRITI-
CAL&SENSOR-STATUS-WATER-LEVEL=CRITICAL&WATER-FLOW=1.0&WATER-

LEVEL=0.0<CR/LF> 

 

 

6.2 HTTP 

Iniciar una medición: 

URI de consulta: http://{host:port}/measurementserver/measure?configID=/{Appl-ID} 

Método de consulta: POST 

Encabezados de consulta: {Accept=[application/json], Content-Length=[0]}     

 

{host:port} debe sustituirse por la dirección TCP/IP y el puerto, por ejemplo 

http://192.168.1.100:1234/measurementserver/, etc. 

 

{Appl-ID} representa la aplicación utilizada para la medición. Las ID de todas las aplicaciones defini-

das en el CoatMaster se almacenan en la lista de aplicaciones con su nombre de aplicación. 

 

Consultar lista de aplicaciones:  

URI de consulta: http://{host:port}/measurementserver/configurations 

Método de consulta: GET 

Encabezados de consulta: {Accept=[application/json], Content-Length=[0]}     
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7 Mantenimiento/ Revisión 

¡El mantenimiento / revisión solo puede realizarlo el personal autorizado! ¡El personal no autorizado 

corre el riesgo de sufrir lesiones personales y provocar daños a CoatMaster! 

 

Utilice únicamente consumibles auténticos y piezas de repuesto de Winterthur Instruments para el 

mantenimiento y la reparación para asegurar el rendimiento y la fiabilidad del sistema. Cualquier 

modificación de las piezas de repuesto usadas solo se permite con la autorización previa por escrito 

de Winterthur Instruments. 

7.1 General 

 

 

 

ADVERTENCIA 

Riesgo de quemaduras por corriente eléctrica. Puede provocar lesiones graves o la muerte. 

Antes de realizar cualquier mantenimiento o reparación, apague el dispositivo y desenchufe el 
cable de alimentación. ¡Los trabajos de mantenimiento solo puede realizarlos el personal 
autorizado! 

 

 

No abra la carcasa de CoatMaster, ni siquiera cuando CoatMaster no está conectado a la 

alimentación. Excepción: Desmontaje de la cubierta trasera para limpiar o cambiar las almohadillas 

del filtro (véase la sección 7.3). La apertura de CoatMaster anulará cualquier responsabilidad e 

invalidará la garantía.  

 

Ponga CoatMaster en funcionamiento como mínimo una vez cada seis meses. 

Si la fuente de luz llega al 0 % o después de un año desde la última revisión (también si el dispositivo 

no está en uso), es necesario que un ingeniero formado del servicio técnico lo revise (véase el 

capítulo ¡Error! No se encuentra el origen de la referencia.). 

 

El software de Desktop Client monitoriza la sustitución de las piezas de CoatMaster. En cuanto el 

estado de las piezas de repuesto se vuelve crítico o se ha alcanzado o superado su margen de 

funcionamiento previsto, se muestra el mensaje correspondiente (véase el capítulo 0). 

 

7.2 Mantenimiento del software 

Con el CoatMaster Web Client, es posible actualizar el software integrado en el CoatMaster y el Coat-

Master Operating System correspondiente. Además, es posible descargar archivos de registro para 

análisis de fallos detallados. Para ello, conecte el ordenador al CoatMaster (ver el capítulo 4.3 y si-

guientes). Utilice un navegador web para acceder a la interfaz web de CoatMaster. 
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Introduzca la dirección IP para la interfaz de conexión correspondiente en el campo URL del navega-

dor (ver el capítulo 4.4.1). Seleccione Administrator (administrador) en el menú principal del Coat-

Master Web Client. 

 
Figura 51. Página de inicio del cliente web  

 

Para conectarse como administrador, utilice el nombre de usuario admin y la contraseña admin. 

7.2.1 Diagnóstico del software CoatMaster 

Para diagnóstico de probelmas, el equipo de soporte de Winterthur Instruments le solicitará en oca-

siones los archivos de registro. Para descargar los archivos de registro del CoatMaster, seleccione 

Diagnostics (Diagnóstico) en la página Administration (Administración) del CoatMaster Web Client. 

 
Figura 52. Descargar diagnósticos en el cliente web 

 

Pulse en Download logs (ZIP) (Descargar registros ZIP) para descargar el archivo de registro. Envíe el 

archivo de registro al equipo de soporte de Winterthur Instruments. 
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7.2.2 Actualización del software integrado en CoatMaster 

Para la actualización del software se requiere un archivo de actualización de Winterthur Instruments. 

Tenga este archivo preparado para el procedimiento de actualización. Seleccione Update Server (Ac-

tualizar servidor) en la página Administration (Administración) del CoatMaster Web Client. 

 
Figura 53. Elegir el archivo para actualizar el software 

 

Cargue el archivo de actualización de CoatMaser mediante la interfaz web y pulse Update server (Ac-

tualizar servidor). Reinicie el CoatMaster después de la actualización e instale el nuevo CoatMaster 

Operating System (ver el capítulo 4.4.2). 

 

7.2.3 Restauración del software integrado en CoatMaster 

Para deshacer una actualización del software, es posible restaurar una versión instalada previamente 

del software integrado en CoatMaster. Seleccione System restore (Restaurar sistema) en la página 

Administration (AdministracióN) del CoatMaster Web Client. 
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Figura 54. Restauración del sistema en el cliente web 

 

Seleccione la versión anterior del software e inicie el proceso de restauración. Reinicie el CoatMaster 

después de la restauración e instale el CoatMaster Operating System correspondiente (ver el capítulo 

4.4.2). 

7.3 Limpieza de la ventana de medición 

Limpie la ventana de medición para eliminar cualquier contaminación mediante aire comprimido sin 

aceite para asegurar el buen rendimiento y fiabilidad de CoatMaster. 

La contaminación resistente se puede retirar con un paño suave sin pelusa y con alcohol (ej. paño 

para limpiar gafas). 

7.4 Rellenar el refrigerante (solo para CoatMaster Inline) 

 

 

 

 

AVISO 

Riesgo de agua dentro de CoatMaster. El uso de agua del grifo como refrigerante puede 
provocar la corrosión de los componentes que entran en contacto con el agua. 

Para enfriar CoatMaster, utilice únicamente el refrigerante de Winterthur Instrument incluido 
en el contenido de la entrega. 
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Figure 55: Rellenar el suministro de agua de CM con refrigerante. 

 

Si se muestra una advertencia de bajo nivel de refrigerante o error (consulte el capítulo 5.3.4), utilice 
el kit de recarga CoatMaster para rellenar el refrigerante de la siguiente manera: 
 

1. Conecte el tubo de llenado con la conexión de llenado del suministro de agua de CM. 

2. Conecte el tubo de ventilación con la conexión de escape del suministro de agua de CM. 

3. Rellene con cuidado el refrigerante dentro del embudo hasta que la columna de líquido se 

haga visible en el tubo de ventilación. El nivel de refrigerante ha alcanzado el máximo y ya se 

pueden quitar los tubos. 
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7.5 Almohadillas de filtro 

7.5.1 CoatMaster 

Inspeccione visualmente las almohadillas del filtro con regularidad. Será necesario limpiarlas cuando 

estén contaminadas. Para ello, proceda de la siguiente manera: 

 Desatornille los dos tornillos en la parte posterior del dispositivo (véase figura ). 

  
Figure 56: CoatMaster – vista trasera. (6) Desatornille para acceder a la parte trasera. 

 

 Remove the filter cover. 

 Take off the filter pads and clean them with compressed air. 

 If the filter pads are highly contaminated, they need to be replaced. 

 Remount the filter cover. 

7.5.2 CoatMaster Inline 

Si se instalan almohadillas de filtros en el bastidor, inspecciónelos visualmente regularmente. Cuando 

estén sucios, necesitan limpieza. Cuando estén muy sucios necesitarán ser sustituidos. 

7.6 Medición de blanco 

Después de las tareas de servcio, debe repetirse la medición de blanco. Esta función se encuentra en 
Preferences > device settings (Preferencias > Ajustes del equipo).  
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Figura 57. Realizar las mediciones de blanco en el software independiente 

 

Los valores para la duración de la medición, la energía lumínica, el umbral de SNR y la posición deci-
mal son solo valores predefinidos. Los valores predefinidos pueden corregirse en los ajustes de la 
aplicación.  

Tiempo de medición (s): Valor predefinido para la duración de la medición 

Energía lumínica (J): Valor predefinido para la energía de la fuente de luz. 

Umbral de SNR (V): Umbral de SNR (relación señal/ruido) para detectar mediciones no válidas. 

Posiciones decimales (espesor): Valor predefinido para el número deseado de cifras para visualizar el 

valor de espesor 

Guardar datos en bruto: Active la casilla de verificación para guardar datos en bruto durante la medi-

ción (solo para fines de servicio). 

 

AVISO   

El CoatMaster no necesita los datos en bruto para el funcionamiento. Recomendamos desactivar esta 

casilla de verificación. 

 

Medición de blanco: Al hacer clic en el botón Start (Inicio), se abre una ventana que solicita cubrir la 

lente IR e iniciar una medición de blanco haciendo clic en Aceptar. Utilice una cubierta de blanco de 

Winterthur Instruments para cubrir la lente IR antes de iniciar las mediciones de blanco. Después de 

colocar la cubierta sobre la lente IR, pulse Aceptar para iniciar las mediciones de blanco. Esta medi-

ción de blanco sirve como referencia para posteriores mediciones de muestras.  
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8 Resolución de Problemas 

Si se produce un error de software (códigos de error 1-14), reinicie el dispositivo. Si el error persiste, 
póngase en contacto con su administrador y proporciónele el código de error.  

 

En caso de defecto de hardware o mal funcionamiento (ej. fuga del líquido refrigerante), proceda de 
la siguiente manera. 
1. Desconecte el dispositivo de la fuente de alimentación de inmediato. 

2. Informe al responsable en la ubicación de funcionamiento sobre el fallo. 

3. ¡Los trabajos de reparación solo puede realizarlos el personal autorizado! 
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9 Datos técnicos 

9.1 Hoja de datos de CoatMaster 

 

 

 

 

CoatMaster  

500 

 

 

 

CoatMaster  

1000 

 

 

 

CoatMaster  

1500 

 

 

CoatMaster  

2000 

Energía 500 J 1000 J 1500 J 2000 J 

Marcado del punto de 

medición 

1 o 4 puntos 1 o 4 puntos 1 o 4 puntos 1 o 4 puntos 

Distancia de medición 5 cm – 30 cm * 5 cm – 30 cm * 5 cm – 40 cm * 5 cm – 50 cm * 

Punto de medición Ø 2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * 

Rango de medición: 

Revestimiento en polvo sin 

curar 

Revestimiento en polvo 

curado 

Esmalte en polvo pre-curado 

Pintura húmeda  

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

Duración de la medición 20 ms – 1000 ms 20 ms – 1000 ms 20 ms – 1000 ms 20 ms – 1000 ms 

Ritmo de repetición de la 

medición 

10 s 10 s 10 s 10 s 

Movimiento del objeto de 

medición 

50 m/min 50 m/min 50 m/min 50 m/min  

Desviación estándar < 4 % ** < 2 % ** < 1 % ** < 0,5 % ** 

Ángulo de tolerancia ± 60° ± 60° ± 60° ± 60° 

Conexión de red CEI 320-C14 CEI 320-C14 CEI 320-C14 CEI 320-C14 

Tensión nominal 230 V CA, 50 Hz 230 V CA, 50 Hz 230V CA, 50 Hz 230V CA, 50 Hz 

Fusible 10 A 10 A 10 A 10 A 

Consumo eléctrico máx. 2000 W máx. 2000 W máx. 2000 W máx. 2000 W 

Temperatura de 

funcionamiento 

5°C – 25°C 5°C – 25°C 5°C – 25°C 5°C – 25°C 

Humedad < 60 % < 60 % < 60 % < 60 % 

Dimensiones 38 x 51 x 20 cm 38 x 51 x 20 cm 38 x 51 x 20 cm 38 x 51 x 20 cm 

Peso 16 kg 16 kg 16 kg 16 kg 

Material de la carcasa aluminio aluminio aluminio aluminio 

Fijación Raíl guía y pies Raíl guía y pies Raíl guía y pies Raíl guía y pies 

Interfaz: 

Ethernet  

WLAN 

Sensor externo 

 

sí 

sí 

sí 

 

sí 

sí 

sí 

 

sí 

sí 

sí 

 

sí 

sí 

sí 

 

*  dependiendo de la distancia / anchura focal 
**  dependiendo del revestimiento y el sustrato  
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9.2 Hoja de datos CoatMaster Inline 

 

 

 

CoatMaster  

Inline 500 

 

 

CoatMaster  

Inline 1000 

 

 

CoatMaster  

Inline 1500 

 

 

CoatMaster  

Inline 2000 
Energía 500 J 1000 J 1500 J 2000 J 

Marcado del punto de medición 1 o 4 puntos 1 o 4 puntos 1 o 4 puntos 1 o 4 puntos 

Distancia de medición 5 cm – 15 cm * 5 cm – 30 cm * 5 cm – 40 cm * 5 cm – 50 cm * 

Punto de medición ø2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * Ø 2 – 20 mm * 

Rango de medición: 

Revestimiento en polvo sin curar 

Revestimiento en polvo curado 

Revestimiento en polvo pre-curado 

Pintura húmeda  

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

 

1-500 µm  

1-1000 µm 

1-1000 µm 

1-100 µm 

Duración de la medición 20 ms – 1000 

ms 

20 ms – 1000 ms 20 ms – 1000 ms 20 ms – 1000 ms 

Ritmo de repetición de la medición 4 s 4 s 4 s 4 s 

Movimiento del objeto de 

medición 

50 m/min * 50 m/min * 50 m/min * 50 m/min * 

Desviación estándar <5 % ** <2 % ** <1 % ** <0,5 % ** 

Ángulo de tolerancia ±60° ±60° ±60° ±60° 

Conexión de red CEI 320-C14 CEI 320-C14 CEI 320-C14 CEI 320-C14 

Tensión nominal 230 V CA, 50 Hz 230 V CA, 50 Hz 230 V CA, 50 Hz 230 V CA, 50 Hz 

Fusible 10 A 10 A 10 A 10 A 

Consumo eléctrico máx. 2000 W máx. 2000 W máx. 2000 W máx. 2000 W 

Temperatura de funcionamiento 

del cabezal de medición 

5°C –50°C 5°C –50°C 5°C –50°C 5°C –50°C 

Temperatura de funcionamiento 

del suministro de agua de CM y del 

suministro de corriente de CM 

5°C -25°C 5°C -25°C 5°C -25°C 5°C -25°C 

Humedad < 60% < 60% < 60% < 60% 

Dimensiones del cabezal de 

medición 

(Al x An x P) en mm 

255 x 245 x 248 255 x 245 x 248 255 x 245 x 248 255 x 245 x 248 

Dimensiones del suministro de 

agua de CM y del suministro de 

corriente de CM 

19“, 8 Alta 

eficiencia 

19“, 8 Alta eficiencia 19“, 8 Alta eficiencia 19“, 8 Alta eficiencia 

Peso del cabezal de medición 

(excluyendo tubos y cable) 

5,2 kg 5,2 kg 5,2 kg 5,2 kg 

Peso del suministro de agua de CM 

y del suministro de corriente de 

CM 

18 kg 18 kg 18 kg 18 kg 

Material de la carcasa aluminio aluminio aluminio aluminio 

Fijación raíl guía  raíl guía  raíl guía  raíl guía  

Longitud del cable entre el cabezal 

de medición y el suministro de 

agua de CM y el suministro de 

corriente de CM 

10 m máx. 10 m máx. 10 m máx. 10 m máx. 
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Diferencia de altura entre el 

cabezal de medición y el suministro 

de agua de CM y el suministro de 

corriente de CM 

5 m máx. 5 m máx. 5 m máx. 5 m máx. 

Interfaz: 

Ethernet  

Sincronización externa  

 

sí 

sí 

 

sí 

sí 

 

sí 

sí 

 

sí 

sí 

 
 

*  dependiendo de la distancia / anchura focal 
**  dependiendo del revestimiento y el sustrato 

 

9.2.1 Información relevante de Dimensiones y Montaje del CoatMaster 
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9.2.2 Información relevante de Dimensiones y Montaje para CoatMaster Inline 
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10 Transporte, embalaje, almacenamientos 

10.1 Inspección del transporte 

Se debe comprobar la entrega nada más recibirla para ver si está completa y en busca de posibles 

daños de tránsito.  

En caso de daños externos visibles, proceda de la siguiente manera: 

 No acepte la entrega o hágalo solo con reservas.  

 Anote el alcance de los daños en los documentos del transporte o en la nota de entrega del 

transportista.  

 Ponga una queja. 

Reclame cualquier daño en cuanto se detecte. Las solicitudes de reclamación solamente pueden 

enviarse dentro de los periodos de reclamación aplicables. 

10.2 Embalaje 

Deseche el material de embalaje de acuerdo con las respectivas leyes y normativas locales vigentes. 

¡Daños ambientales causados por una eliminación incorrecta de los residuos! Los materiales de 

embalaje son materias primas de valor y se pueden seguir usando en muchos casos o bien 

reacondicionar de manera sensata y reciclarse. 

 Deseche el material de embalaje de una manera respetuosa con el medioambiente. 

 Respete las normativas locales válidas en cuanto a la eliminación. En caso necesario, haga 

uso de una empresa especializada en eliminación de residuos para desechar el material de 

embalaje. 

10.3 Almacenamiento 

Posiblemente, en el embalaje haya instrucciones sobre el almacenamiento que excedan los 

requisitos mencionados aquí. Se deben respetar. 

Almacene los paquetes en las siguientes condiciones: 

 No almacenar en exteriores 

 Almacenar en un lugar seco y libre de polvo 

 No exponer a medios agresivos 

 Proteger frente a la radiación solar 

 Evitar impactos mecánicos y vibraciones 

 Temperatura de almacenamiento: 15 a 25 °C 

 Humedad relativa: máx. 60 % 

 

Para un almacenamiento de más de 3 meses: 

 Compruebe regularmente la condición general de todas las piezas y del embalaje 

 En caso necesario, renueve o sustituya la conservación 

 



Manual de uso de CoatMaster   

 

 

88/88  

 

 

 

 

 

 
 

943 82 00 82 

info@neurtek.com 

www.neurtek.com 
 

 

 

 

http://www.neurtek.com/

